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Preface
Notice
The company reserves the right to revise this publication or to change its contents without notice. Information
contained herein is for reference only and does not constitute a commitment on the part of the manufacturer or
any subsequent vendor. They assume no responsibility or liability for any errors or inaccuracies that may appear
in this publication nor are they in anyway responsible for any loss or damage resulting from the use (or misuse)
of this publication.
This publication and any accompanying software may not, in whole or in part, be reproduced, translated, trans-
mitted or reduced to any machine readable form without prior consent from the vendor, manufacturer or creators
of this publication, except for copies kept by the user for backup purposes.
Brand and product names mentioned in this publication may or may not be copyrights and/or registered trade-
marks of their respective companies. They are mentioned for identification purposes only and are not intended
as an endorsement of that product or its manufacturer.
©September 2009

Trademarks
Intel and Atom are trademarks/registered trademarks of Intel Corporation.
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Preface
FCC Statement
(Federal Communications Commission)
You are cautioned that changes or modifications not expressly approved by the party responsible for compliance
could void the user's authority to operate the equipment.

This equipment has been tested and found to comply with the limits for a Class B digital device, pursuant to Part
15 of the FCC Rules. These limits are designed to provide reasonable protection against harmful interference in
a residential installation. This equipment generates, uses and can radiate radio frequency energy and, if not in-
stalled and used in accordance with the instructions, may cause harmful interference to radio communications.
However, there is no guarantee that interference will not occur in a particular installation. If this equipment does
cause harmful interference to radio or television reception, which can be determined by turning the equipment
off and on, the user is encouraged to try to correct the interference by one or more of the following measures:

• Re orient or relocate the receiving antenna.
• Increase the separation between the equipment and receiver.
• Connect the equipment into an outlet on a circuit different from that to which the receiver is connected.
• Consult the service representative or an experienced radio/TV technician for help.

Operation is subject to the following two conditions:

1. This device may not cause interference.
And

2. This device must accept any interference, including interference that may cause undesired operation of the 
device.
II



Preface
FCC RF Radiation Exposure Statement:

1. This Transmitter must not be co-located or operating in conjunction with any other antenna or transmitter.

2. This equipment complies with FCC RF radiation exposure limits set forth for an uncontrolled environment. This 
equipment should be installed and operated with a minimum distance of 20 centimeters between the radiator 
and your body.

Warning
Use only shielded cables to connect I/O devices to this equipment. You are cautioned that changes or modifications not ex-
pressly approved by the manufacturer for compliance with the above standards could void your authority to operate the
equipment.
III
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IMPORTANT SAFETY INSTRUCTIONS
Follow basic safety precautions, including those listed below, to reduce the risk of fire, electric shock, and injury
to persons when using any electrical equipment:

1. Do not use this product near water, for example near a bath tub, wash bowl, kitchen sink or laundry tub, in a wet 
basement or near a swimming pool.

2. Avoid using this equipment with a telephone line (other than a cordless type) during an electrical storm. There 
may be a remote risk of electrical shock from lightning.

3. Do not use the telephone to report a gas leak in the vicinity of the leak.
4. Use only the power cord and batteries indicated in this manual. Do not dispose of batteries in a fire. They may 

explode. Check with local codes for possible special disposal instructions.
5. This product is intended to be supplied by a Listed Power Unit (Full Range AC/DC Adapter – AC Input 100 - 

240V, 50 - 60Hz, DC Output 19V, 1.57A/1.58A).

This Computer’s Optical Device is a Laser Class 1 Product
IV
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Instructions for Care and Operation
The notebook computer is quite rugged, but it can be damaged. To prevent this, follow these suggestions:

1. Don’t drop it, or expose it to shock. If the computer falls, the case and the components could be damaged.

2. Keep it dry, and don’t overheat it. Keep the computer and power supply away from any kind of heating ele-
ment. This is an electrical appliance. If water or any other liquid gets into it, the computer could be badly dam-
aged.

Do not expose the computer 
to any shock or vibration.

Do not place it on an unstable 
surface.

Do not place anything heavy 
on the computer.

Do not expose it to excessive 
heat or direct sunlight.

Do not leave it in a place 
where foreign matter or mois-
ture may affect the system.

Don’t use or store the com-
puter in a humid environment.

Do not place the computer on 
any surface that will block the 
Vents/Fan Intakes.
V
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3. Avoid interference. Keep the computer away from high capacity transformers, electric motors, and other 
strong magnetic fields. These can hinder proper performance and damage your data.

4. Follow the proper working procedures for the computer. Shut the computer down properly and don’t forget 
to save your work. Remember to periodically save your data as data may be lost if the battery is depleted.

5. Take care when using peripheral devices.

Do not turn off the power 
until you properly shut down 
all programs.

Do not turn off any peripheral 
devices when the computer is 
on.

Do not disassemble the com-
puter by yourself.

Perform routine maintenance 
on your computer.

Use only approved brands of 
peripherals.

Unplug the power cord before 
attaching peripheral devices.
VI
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Power Safety
The computer has specific power requirements:

• Only use a power adapter approved for use with this computer.
• Your AC/DC adapter may be designed for international travel but it still requires a 

steady, uninterrupted power supply. If you are unsure of your local power specifications, 
consult your service representative or local power company.

• The power adapter may have either a 2-prong or a 3-prong grounded plug. The third 
prong is an important safety feature; do not defeat its purpose. If you do not have access 
to a compatible outlet, have a qualified electrician install one.

• When you want to unplug the power cord, be sure to disconnect it by the plug head, not 
by its wire.

• Make sure the socket and any extension cord(s) you use can support the total current 
load of all the connected devices.

• Before cleaning the computer, make sure it is disconnected from any external power 
supplies (i.e. AC/DC adapter or car adapter).

Do not plug in the power 
cord if you are wet.

Do not use the power cord if 
it is broken.

Do not place heavy objects 
on the power cord.

Power Safety 
Warning

Before you undertake
any upgrade proce-
dures, make sure that
you have turned off the
power, and discon-
nected all peripherals
and cables (including
telephone lines). It is
advisable to also re-
move your battery in
order to prevent acci-
dentally turning the
machine on.
VII
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Battery Precautions
• Only use batteries designed for this computer. The wrong battery type may explode, leak or damage the computer.
• Do not remove any batteries from the computer while it is powered on.
• Do not continue to use a battery that has been dropped, or that appears damaged (e.g. bent or twisted) in any way. Even 

if the computer continues to work with a damaged battery in place, it may cause circuit damage, which may possibly 
result in fire.

• Recharge the batteries using the notebook’s system. Incorrect recharging may make the battery explode.
• Do not try to repair a battery pack. Refer any battery pack repair or replacement to your service representative or qual-

ified service personnel.
• Keep children away from, and promptly dispose of a damaged battery. Always dispose of batteries carefully. Batteries 

may explode or leak if exposed to fire, or improperly handled or discarded.
• Keep the battery away from metal appliances.
• Affix tape to the battery contacts before disposing of the battery.
• Do not touch the battery contacts with your hands or metal objects.

Battery Disposal & Caution
The product that you have purchased contains a rechargeable battery. The battery is recyclable. At the end of its useful life,
under various state and local laws, it may be illegal to dispose of this battery into the municipal waste stream. Check with
your local solid waste officials for details in your area for recycling options or proper disposal.

Danger of explosion if battery is incorrectly replaced. Replace only with the same or equivalent type recommended by the
manufacturer. Discard used battery according to the manufacturer’s instructions.
VIII
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Cleaning
Do not apply cleaner directly to the computer; use a soft clean cloth. 
Do not use volatile (petroleum distillates) or abrasive cleaners on any part of the computer.

Servicing
Do not attempt to service the computer yourself. Doing so may violate your warranty and expose you and the
computer to electric shock. Refer all servicing to authorized service personnel. Unplug the computer from the
power supply. Then refer servicing to qualified service personnel under any of the following conditions:

• When the power cord or AC/DC adapter is damaged or frayed.
• If the computer has been exposed to rain or other liquids.
• If the computer does not work normally when you follow the operating instructions.
• If the computer has been dropped or damaged (do not touch the poisonous liquid if the LCD panel breaks).
• If there is an unusual odor, heat or smoke coming from your computer.

Removal Warning
When removing any cover(s) and screw(s) for the purposes of device upgrade, remember to replace the cover(s) and
screw(s) before turning the computer on.
IX
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Travel Considerations

Packing
As you get ready for your trip, run through this list to make sure the system is ready to go:

1. Check that the battery pack and any spares are fully charged.
2. Power off the computer and peripherals.
3. Close the display panel and make sure it’s latched.
4. Disconnect the AC/DC adapter and cables. Stow them in the carrying bag. 
5. The AC/DC adapter uses voltages from 100 to 240 volts so you won’t need a second voltage adapter. However, 

check with your travel agent to see if you need any socket adapters.
6. Put the notebook in its carrying bag and secure it with the bag’s straps.
7. If you’re taking any peripherals (e.g. a printer, mouse or digital camera), pack them and those devices’ adapters 

and/or cables.
8. Anticipate customs - Some jurisdictions may have import restrictions or require proof of ownership for both hard-

ware and software. Make sure your documents are prepared.

Power Off Before Traveling
Make sure that your notebook is completely powered off before putting it into a travel bag (or any such container). Putting a
notebook which is powered on in a travel bag may cause the vent(s)/fan intake(s)/outlet(s) to be blocked. To prevent your
computer from overheating make sure nothing blocks the vent(s)/fan intake(s)/outlet(s) while the computer is in use.
X
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On the Road
In addition to the general safety and maintenance suggestions in this preface, and Chapter 8: Troubleshooting,
keep these points in mind:

Hand-carry the notebook - For security, don’t let it out of your sight. In some areas, computer theft is very
common. Don’t check it with normal luggage. Baggage handlers may not be sufficiently careful. Avoid knock-
ing the computer against hard objects.

Beware of Electromagnetic fields - Devices such as metal detectors & X-ray machines can damage the com-
puter, hard disk, floppy disks, and other media. They may also destroy any stored data - Pass your computer and
disks around the devices. Ask security officials to hand-inspect them (you may be asked to turn it on). Note:
Some airports also scan luggage with these devices.

Fly safely - Most airlines have regulations about the use of computers and other electronic devices in flight.
These restrictions are for your safety, follow them. If you stow the notebook in an overhead compartment, make
sure it’s secure. Contents may shift and/or fall out when the compartment is opened.

Get power where you can - If an electrical outlet is available, use the AC/DC adapter and keep your battery(ies)
charged.

Keep it dry - If you move quickly from a cold to a warm location, water vapor can condense inside the computer.
Wait a few minutes before turning it on so that any moisture can evaporate.
XI
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Developing Good Work Habits
Developing good work habits is important if you need to work in front of the computer for long periods of time.
Improper work habits can result in discomfort or serious injury from repetitive strain to your hands, wrists or
other joints. The following are some tips to reduce the strain:

•Adjust the height of the chair and/or desk so that the keyboard is at or slightly below the 
level of your elbow. Keep your forearms, wrists, and hands in a relaxed position.
•Your knees should be slightly higher than your hips. Place your feet flat on the floor or on a 
footrest if necessary.
•Use a chair with a back and adjust it to support your lower back comfortably.
•Sit straight so that your knees, hips and elbows form approximately 90-degree angles when 
you are working.

• Take periodic breaks if you are using the computer for long periods of time.

Remember to:
•Alter your posture frequently.
•Stretch and exercise your body several times a day.
•Take periodic breaks when you work at the computer for long periods of time. Frequent and 
short breaks are better than fewer and longer breaks.
XII
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Lighting
Proper lighting and comfortable display viewing angle can reduce eye strain and muscle fatigue in your neck and
shoulders.

• Position the display to avoid glare or reflections from overhead lighting or outside sources of light.
• Keep the display screen clean and set the brightness and contrast to levels that allow you to see the screen clearly.
• Position the display directly in front of you at a comfortable viewing distance.
• Adjust the display-viewing angle to find the best position.

LCD Screen Care
To prevent image persistence on LCD monitors (caused by the continuous display of graphics on the screen for
an extended period of time) take the following precautions:

• Set the Windows Power Plans to turn the screen off after a few minutes of screen idle time.
• Use a rotating, moving or blank screen saver (this prevents an image from being displayed too long).
• Rotate desktop background images every few days.
• Turn the monitor off when the system is not in use.
XIII
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Quick Start Guide 1
Chapter 1: Quick Start Guide
Overview
This Quick Start Guide is a brief introduction to the basic features of your computer, to navigating around the
computer and to getting your system started. The remainder of the manual covers the following:

• Chapter 2 A guide to using some of the main features of the computer e.g. the storage devices (hard disk, 
optical device, 7-in-1 card reader), TouchPad & Mouse, Audio & Printer.

• Chapter 3 The computer’s power saving options.
• Chapter 4 The installation of the drivers and utilities essential to the operation or improvement of some of the 

computer’s subsystems.
• Chapter 5 An outline of the computer’s built-in software or BIOS (Basic Input Output System).
• Chapter 6 Instructions for upgrading your computer.
• Chapter 7 A quick guide to the computer’s Bluetooth, PC Camera, Wireless LAN and 3.75G/HSPA mod-

ules (some of which may be optional depending on your purchase configuration).
• Chapter 8 A troubleshooting guide.
• Appendix A Definitions of the interface, ports/jacks which allow your computer to communicate with external 

devices.
• Appendix B Information on the Intel Video driver controls.
• Appendix C The computer’s specification.
• Appendix D Windows 7 driver installation information.
Overview 1 - 1
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Advanced Users
If you are an advanced user you may skip over most of this Quick Start Guide. However you may find it useful
to refer to “What to Install” on page 4 - 1, “BIOS Utilities” on page 5 - 1 and “Upgrading The Computer” on
page 6 - 1 in the reminder of the User’s Manual. You may also find the notes marked with a  of interest to you.

Beginners and Not-So-Advanced Users
If you are new to computers (or do not have an advanced knowledge of them) then
the information contained in the Quick Start Guide should be enough to get you up
and running. Eventually you should try to look through all the documentation (more
detailed descriptions of the functions, setup and system controls are covered in the
remainder of the User’s Manual), but do not worry if you do not understand every-
thing the first time. Keep this manual nearby and refer to it to learn as you go. You
may find it useful to refer to the notes marked with a  as indicated in the margin.
For a more detailed description of any of the interface ports and jacks see “Interface
(Ports & Jacks)” on page  A - 1.

Warning Boxes
No matter what your level please pay careful attention to the warning and safety information indicated by the

 symbol. Also please note the safety and handling instructions as indicated in the Preface.

Notes

Check the light colored
boxes with the mark
above to find detailed in-
formation about the com-
puter’s features. 
1 - 2 Overview
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Not Included
Operating Systems (e.g. Windows XP/Windows 7) and applications (e.g. word processing, spreadsheet and da-
tabase programs) have their own manuals, so please consult the appropriate manuals.

Drivers

If you are installing new system software, or are re-configuring your computer for a different system, you will need to install
the drivers listed in “Drivers & Utilities” on page 4 - 1. Drivers are programs which act as an interface between the com-
puter and a hardware component e.g. a wireless network module. It is very important that you install the drivers in the order
listed. You will be unable to use most advanced controls until the necessary drivers and utilities are properly installed. If
your system hasn’t been properly configured (your service representative may have already done that for you); refer to
Chapter 4 for installation instructions.

Ports and Jacks

See “Notebook Ports and Jacks” on page A - 2 for a description of the interface (ports & jacks) which allow your com-
puter to communicate with external devices, connect to the internet etc.
Overview 1 - 3
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Model Differences
This notebook series includes two different model types which differ slightly in design style. Note that your mod-
el’s appearance may appear slightly different from those pictured throughout this manual.

System Software
Your computer may already come with system software pre-installed. Where this is not the case, or where you
are re-configuring your computer for a different system, you will find the following operating systems are sup-
ported. See “Installed O/S (Advanced Menu)” on page 5 - 8 for information on setting the O/S in the BIOS be-
fore installing the operating system.

Table 1 - 1 - Operating Systems Supported

Operating System & Version Note

Windows XP (Home or Professional) 
with Service Pack 3 

In order to run Windows XP without limitations or decreased performance,
your computer requires a minimum 512MB of system memory (RAM)

Windows 7 *See Appendix D for driver installation information on Windows 7.

Windows Vista Service Pack 3

Make sure you install Windows XP Service Pack 3 (or a Windows XP version which includes Service Pack 3) before
installing any drivers. Go to the Microsoft website for download details, or contact your service center.
1 - 4 Overview
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System Startup
1. Remove all packing materials, and place the computer on a stable surface.
2. Securely attach any peripherals you want to use with the notebook (e.g. keyboard and mouse) to their ports.
3. Attach the AC/DC adapter to the DC-In jack on the left of the computer, then plug the AC power cord into an 

outlet, and connect the AC power cord to the AC/DC adapter.
4. Use one hand to carefully raise the lid/LCD to a comfortable viewing angle, while using the other hand (as illustrated 

in Figure 1 - 1 below) to support the base of the computer (Note: Never lift the computer by the lid/LCD).
5. Press the power button to turn the computer “on”.

Figure 1 - 1 - Opening the Lid/LCD/Computer with AC/DC Adapter Plugged-In

Shutdown

Note that you should always shut your computer down by choosing the Turn Off Computer command from the Start
menu in Windows. This will help prevent hard disk or system problems.
System Startup 1 - 5
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System Map: LCD Panel Open - Model A

Figure 1 - 2
LCD Panel Open

Model A

1. Built-In PC Camera 
(Optional)

2. LCD
3. Speakers
4. Keyboard
5. Built-In Microphone
6. Touchpad & 

Buttons

2

5

1

4

6

3

Wireless Device 
Operation Aboard 

Aircraft

The use of any portable elec-
tronic transmission devices
aboard aircraft is usually pro-
hibited. Make sure the mod-
ule(s) are OFF if you are using
the computer aboard aircraft.

Use the key combinations to
toggle power to the WLAN/
Bluetooth modules, and
check the LED indicator icon
to see if the modules are pow-
ered on or not (see Table 1 -
2, on page 1 - 9/ Table 1 - 3,
on page 1 - 11).
1 - 6 System Map: LCD Panel Open - Model A
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System Map: LCD Panel Open - Model B

Figure 1 - 3
LCD Panel Open

Model B

1. Built-In PC Camera 
(Optional)

2. LCD
3. Speakers
4. Keyboard
5. Built-In Microphone
6. Touchpad & 

Buttons

2

5

1

4

6

3

Wireless Device 
Operation Aboard 

Aircraft

The use of any portable elec-
tronic transmission devices
aboard aircraft is usually pro-
hibited. Make sure the mod-
ule(s) are OFF if you are using
the computer aboard aircraft.

Use the key combinations to
toggle power to the WLAN/
Bluetooth modules, and
check the LED indicator icon
to see if the modules are pow-
ered on or not (see Table 1 -
2, on page 1 - 9/ Table 1 - 3,
on page 1 - 11).
System Map: LCD Panel Open - Model B 1 - 7
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Keyboard
The keyboard has a numerical keypad for easy numeric data input, and features function keys to allow you to change
operational features instantly. See Table 1 - 2, on page 1 - 9 for details on the function keys.

Figure  1 - 4 - Keyboard

Special Characters

Some software applications allow the
number-keys to be used with Alt to pro-
duce special characters. These special
characters can only be produced by us-
ing the numeric keypad. Regular num-
ber keys (in the upper row of the
keyboard) will not work. Make sure that
NumLk is on.

Other Keyboards

If your keyboard is damaged or you just want to make a change, you can use any standard USB keyboard. The system
will detect and enable it automatically. However special functions/hot-keys unique to the system’s regular keyboard may
not work.
1 - 8 Keyboard
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Function/Hot Key Indicators
The function keys (F1 - F12 etc.) will act as hot keys when pressed while the Fn key is held down. In addition
to the basic function key combinations; visual indicators are available when the hot key utility provided is in-
stalled. When the driver is installed, an icon  will appear in the taskbar.

Table 1 - 2 - Function & Hot Key Indicators

Keys Function Keys Function

Fn + ~ Play/Pause (in Audio/Video Programs) Fn + F8/F9 Brightness Decrease/Increase 

Fn + F1 TouchPad Toggle Fn + F10 PC Camera Power Toggle 

Fn + F2 Turn LCD Backlight Off
(Press a key to or use TouchPad to turn on) Fn + F11 WLAN Module Power Toggle 

Fn + F3 Mute Toggle Fn + F12 Bluetooth Module Power Toggle 

Fn + F4 Sleep Toggle Fn + 3.75G/HSPA Module Power Toggle

Fn + F5/F6 Volume Decrease/Increase Fn + NumLk

Fn + ScrLk

Caps Lock

 Number Lock Toggle

Scroll Lock Toggle

Caps Lock ToggleFn + F7 Display Toggle
Function/Hot Key Indicators 1 - 9
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System Map: Front & Rear ViewsFigure 1 - 5

Front & Rear Views

1. LED Power & 
Communication 
Indicators

2. 7-in-1 Card Reader
3. Microphone-In 

Jack
4. Headphone-Out 

Jack
5. Battery

1 43

5

2
Model A

Model B

Model A

Model B

7-in-1 Card Reader

The card reader allows you to use the most popular digital storage card formats:

MMC (MultiMedia Card) / SD (Secure Digital) / MS (Memory Stick) / 
MS Pro (Memory Stick Pro) / MS Duo (requires PC adapter) / 

Mini SD (requires PC adapter) / RS MMC (requires PC adapter)

1
432

5

1 - 10 System Map: Front & Rear Views
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Table 1 - 3 - LED Indicators

Icon Color Description

Orange DC Power is Plugged In

Green The Computer is On

Blinking Green The Computer is in Sleep Mode

Orange The Battery is Charging

Green The Battery is Fully Charged

Blinking Orange The Battery Has Reached Critically Low Power Status

Green Hard Disk Activity

Green The (optional) Wireless LAN Module is Powered On

Orange The (optional) Bluetooth Module is Powered On
System Map: Front & Rear Views 1 - 11
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System Map: Left & Right Views

Figure 1 - 6
Left & Right Views

1. Security Lock Slot
2. DC-In Jack
3. RJ-45 LAN Jack
4. 2 * USB 2.0 Ports
5. External Monitor 

Port
6. Hard Disk Drive 

Bay
7. Vent/Fan Intake/

Outlet
8. Power Button 

(Model A 
Computers Only)

1
42

6
8

3 5

7

4

Model A

Model A

Model B

Model B

4

1

2
3 544

6 7
1 - 12 System Map: Left & Right Views
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External Optical (CD/DVD) Device Drives

To install applications and drivers etc. you will need to
attach an external optical CD/DVD device to the USB
ports. If you are having problems detecting external
ODDs, enable the enhanced detection of these devic-
es see “Enhance USB ODD detection (Advanced
Menu)” on page 5 - 10.

Overheating

To prevent your computer from overheating make
sure nothing blocks the vent(s)/fan intake(s) while the
computer is in use.
System Map: Left & Right Views 1 - 13
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System Map: Bottom View 

Figure 1 - 7
Bottom View

1. Battery
2. Vent/Fan Intake/

Outlet (Model B 
Computers Only)

3. Hard Disk Bay 
(Model B 
Computers Only)

CPU

The CPU is not a user
serviceable part. Open-
ing this compartment, or
accessing the CPU in
any way, may violate
your warranty.

1

1

2

2

3

3.75G/HSPA Module USIM 
Card

The 3.75G/HSPA module’s USIM
card location is located under the bat-
tery compartment. See page 1 - 15
for instructions on installing the
3.75G/HSPA USIM card.

Battery Information

Always completely discharge, then
fully charge, a new battery before us-
ing it. Completely discharge and
charge the battery at least once every
30 days or after about 20 partial dis-
charges.

Model A

Model B
1 - 14 System Map: Bottom View
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3.75G/HSPA Module USIM Card Installation
If you have included an optional 3.75G/HSPA module in your purchase option, follow the instructions below to
install the USIM card (which will be provided by your service provider), and then run the 3G Watcher/HSPA
Modem Interface application. See “3G Watcher” on page 7 - 20/“HSPA Modem Interface” on page 7 - 27/
“Mobile Partner” on page 7 - 36 for instructions on installing the program etc. 

1. Turn off the computer, and turn it over and then remove the battery (slide the latches in the direction indicated 
below and slide the battery out).

2. Insert the USIM card as illustrated below until it clicks fully into position, and replace the battery.

Figure 1 - 8 - Battery Removal & USIM Card Insertion

Model A

Model B

Model A

Model B
System Map: Bottom View 1 - 15
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Windows XP Start Menu & Control Panel
Most of the control panels, utilities and programs within Windows XP (and most other Windows versions) are
accessed from the Start menu. When you install programs and utilities they will be installed on your hard disk
drive, and a shortcut will usually be placed in the Start menu and/or the desktop. You can customize the look of
the Start menu by right-clicking the Start menu and selecting Properties from the menu.

In many instances throughout this manual you will see an instruction to open the Control Panel. The Control
Panel is accessed from the Start menu, and it allows you to configure the settings for most of the key features
in Windows (e.g. power, video, network, audio etc.). Windows XP provides basic controls for many of the fea-
tures, however many new controls are added (or existing ones are enhanced) when you install the drivers. To see
all controls it may be necessary to toggle off Category View.

Figure 1 - 9 - Start Menu & Control Panel

Click here to toggle Category View

 

1 - 16 Windows XP Start Menu & Control Panel
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Video Features
You can switch display devices, and configure display options, from the Display Properties control panel in
Windows as long as the appropriate video driver is installed. For more detailed video information see “Intel
Video Driver Controls” on page B - 1.

To access Display Properties in Windows:
1. Click Start, point to Settings and click Control Panel (or just click Control Panel).
2. Double-click Display (icon) - In the Appearances and Themes category.
3. Click Settings (tab) in the Display Properties dialog box.
4. Move the slider to the preferred setting in Screen resolution  (Figure 1 - 10 on page 1 - 18).
5. Click the arrow, and scroll to the preferred setting in Color quality (Figure 1 - 10 on page 1 - 18).
6. You can also access Display Properties by right-clicking the desktop and scrolling down and clicking 

Properties. Click Settings (tab) and adjust as above.
7. Open the Display Properties control panel, and click Advanced (button)  (Figure 1 - 10 on page 1 - 18) to 

bring up the Advanced properties tabs.
8. Click the Intel(R) Graphics Media Accelerator Driver for Mobile tab, and click Graphics Properties (button) 

to make any video adjustments you require.
9. You can also access Graphics Properties from the Windows Intel(R) GMA Driver for Mobile control panel, or 

from the taskbar icon .

Dynamic Video Memory Technology
Intel® DVMT automatically and dynamically allocates as much (up to 128MB) system memory (RAM) as need-
ed to the video system (the video driver must be installed). DVMT returns whatever memory is no longer need-
ed to the operating system.

1
2

3

Video Features 1 - 17
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Display & Graphics Properties

Figure 1 - 10 - Display & Graphics Properties

1 2

3

Taskbar Icon

You can also access the con-
troller properties from the task-
bar. Click on the icon to bring
up the menu and scroll to
Graphics Properties.

If you cannot see the tray icon
go to the Intel(R) Graphics
Media Accelerator Driver for
Mobile tab and click the
“Show Tray Icon” tickbox. Al-
ternatively right-click the desk-
top and select Graphics
Options > Tray Icon > En-
able.
1 - 18 Video Features
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Power Management Features
The Power Options control panel icon in Windows allows you to configure power management features for
your computer. You may conserve power through individual components such as the monitor or hard disk (by
means of Power Schemes), or you may use either Standby or Hibernate mode to conserve power throughout
the system (enable Hibernate support from the control panel as pictured in Figure 1 - 11).

Figure 1 - 11 - Power Options
The computer’s power button, sleep button (Fn + F4 key combination), and lid (closing the lid) may be set to
send the computer in to either Standby or Hibernate mode.

Power Saving and Performance
Power Schemes may have an affect on your computer performance.
Power Management Features 1 - 19
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Chapter 2: Features & Components
Overview
Read this chapter to learn more about the following main features and components
of the computer:

• Hard Disk Drive
• External USB Optical (CD/DVD) Device
• 7-in-1 Card Reader
• TouchPad and Buttons/Mouse
• Audio Features
• Adding a Printer
Overview 2 - 1
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 Hard Disk Drive
The hard disk drive is used to store your data in the computer. The hard disk can be
taken out to accommodate other 2.5" serial (SATA) HDDs with a height of 9.5 mm.

The HDD is located in the bay on the right of your computer, and this can be opened
after elevating the keyboard and accessing the screw securing the hard disk assem-
bly. For further details see “Upgrading the HDD” on page 6 - 4.

Power Safety

Before attempting to ac-
cess any of the internal
components of your
computer please ensure
that the machine is not
connected to the AC
power, and that the ma-
chine is turned off. Also
ensure that all peripher-
al cables, including
phone lines, are discon-
nected from the comput-
er.

Figure 2 - 1
HDD Bay

HDD Bay

Note that the HDD bay can be
accessed by elevating the
keyboard (see “Upgrading
the HDD” on page 6 - 4).

Hard Disk Drive Speeds

If you are going to upgrade/replace the hard disk
drive, note that It is recommended that HDDs of a
maximum speed of 5400 RPM are used. DO NOT
use 7200rpm or higher HDDs. 

Model A
Model B

Hard Disk Drive Bay
2 - 2 Hard Disk Drive
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External USB Optical (CD/DVD) Device
An external USB optical (CD/DVD) device is available as an option for this com-
puter. The optical device may be used as a boot device if properly set in the BIOS
(see “Boot Menu” on page 5 - 13).

Loading Discs
To insert a CD/DVD, simply slide the disc into the disc slot with label-side facing
up. The busy indicator will light up while data is being accessed, or while a disc is
playing. If power is unexpectedly interrupted, insert an object such as a straightened
paper clip into the emergency eject hole to eject the disc.

USB Cables

You can connect the op-
tional USB optical de-
vice using one of the
USB cables. However if
you are experiencing
connection or power
problems, connect both
USB cables from the de-
vice to the computer. 

 Figure 2 - 2
Optional Optical 

Device Drive

External Optical (CD/DVD) 
Device Drives

To install applications and drivers
etc. you will need to attach an exter-
nal optical CD/DVD device to the
USB ports. If you are having prob-
lems detecting external ODDs, en-
able the enhanced detection of
these devices see “Enhance USB
ODD detection (Advanced
Menu)” on page 5 - 10.
External USB Optical (CD/DVD) Device 2 - 3
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 Handling CDs or DVDs
Proper handling of your CDs/DVDs will prevent them from being damaged. Please
follow the advice below to make sure that the data stored on your CDs/DVDs can be
accessed.

Note the following:

• Hold the CD or DVD by the edges; do not touch the surface of the disc.
• Use a clean, soft, dry cloth to remove dust or fingerprints.
• Do not write on the surface with a pen.
• Do not attach paper or other materials to the surface of the disc.
• Do not store or place the CD or DVD in high-temperature areas.
• Do not use benzene, thinner, or other cleaners to clean the CD or DVD.
• Do not bend the CD or DVD.
• Do not drop or subject the CD or DVD to shock.

CD Emergency Eject

If you need to manually
eject a CD (e.g. due to
an unexpected power
interruption) you may
push the end of a
straightened paper clip
into the emergency eject
hole. However please
do NOT use a sharp-
ened pencil or similar
object that may break
and become lodged in
the hole.

Disk Eject Warning

Don’t try to remove a
CD/DVD while the sys-
tem is accessing it. This
may cause the system
to “crash”.
2 - 4 External USB Optical (CD/DVD) Device
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DVD Regional Codes
Go to the Control Panel and double-click Device Manager (Hardware and
Sound), then click the + next to DVD/CD-ROM drives. Double-click on the DVD-
ROM device to bring up the Properties dialog box, and select the DVD Region
(tab) to bring up the control panel to allow you to adjust the regional code.

DVD region detection is device dependent, not OS-dependent. You can select your
module’s region code 5 times. The fifth selection is permanent. This cannot be al-
tered even if you change your operating system or you use the module in another
computer.

DVD Regional Coding

Region Geographical Location

1 USA, Canada

2 Western Europe, Japan, South Africa, Middle East & Egypt

3 South-East Asia, Taiwan, South Korea, The Philippines, 
Indonesia, Hong Kong

4 South & Central America, Mexico, Australia, New Zealand

5 N Korea, Russia, Eastern Europe, India & Most of Africa

6 China

Table 2 - 1
DVD Regional Coding
External USB Optical (CD/DVD) Device 2 - 5
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 7-in-1 Card Reader
The card reader allows you to use some of the latest digital storage cards. Push the
card into the slot and it will appear as a removable device, and can be accessed in
the same way as your hard disk (s). Make sure you install the Card Reader driver
(see “Card Reader” on page 4 - 5).

*Note: The PC adapters are usually supplied with these cards.

Card Reader Cover

Make sure you keep the
rubber cover provided in
the card reader when
not in use. This will help
prevent foreign objects
and/or dust getting in to
the card reader.

 Figure 2 - 3
Right View

1. Card Reader

• MMC (MultiMedia Card)
• SD (Secure Digital)
• MS (Memory Stick)
• MS Pro (Memory Stick Pro)

• MS Duo (requires PC adapter*)
• Mini SD (requires PC adapter*)
• RS MMC (requires PC adapter*)

1

1

2 - 6 7-in-1 Card Reader
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TouchPad and Buttons/Mouse
The TouchPad is an alternative to the mouse; however, you can also add a mouse to
your computer through one of the USB ports. The TouchPad buttons function in
much the same way as a two-button mouse. Make sure you have installed the Touch-
Pad driver (see “TouchPad” on page 4 - 5).

You can configure the mouse functions from the Mouse Properties control panel.
Click Start, point to Settings and click Control Panel (or just click Control Panel),
and then double-click Mouse.

Click Hardware (tab) and double-click Properties to access Advanced Settings.

Mouse Driver

If you are using an exter-
nal mouse your operat-
ing system may be able
to auto-configure your
mouse during its instal-
lation or only enable its
basic functions. Be sure
to check the device’s
user documentation for
details.

 Figure 2 - 4
Mouse Properties
TouchPad and Buttons/Mouse 2 - 7
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 Audio Features
You can configure the audio options on your computer from the Sounds and Audio
Devices Windows control panel, or from the Realtek HD Audio Manager icon
in the taskbar/control panel (this will bring up the Realtek Audio Configuration
menus). The volume may also be adjusted by means of the Fn + F5/F6 key combi-
nation.

Sound Volume 
Adjustment

How high the sound
volume can be set de-
pends on the setting of
the volume control
within Windows (and
the volume control
function keys on the
computer). Click the
Volume icon on the
taskbar to check the
setting.

 Figure 2 - 5
Realtek HD Audio 
2 - 8 Audio Features
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Audio Recording from Microphone
If you want to record from either the built-in microphone or an external microphone,
then configure the audio options as follows:

1. Double-click the Realtek HD Audio Manager icon  in the taskbar/control panel.
2. Click Mixer (tab).
3. Click the button under Mic Volume to select it (you can boost the volume level as 

high as required).
4. Click OK to close the control panel.
 

 Figure 2 - 6
Mixer - Mic Volume
Audio Features 2 - 9
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 Adding a Printer
The most commonly used peripheral is a printer. The following conventions will
help you to add a printer; however it is always best to refer to the printer manual for
specific instructions and configuration options.

USB Printer
Most current printers have a USB interface connection. You may use any one of the
ports to connect the printer.

Install Instructions:
1. Set up the printer according to its instructions (unpacking, paper tray, toner/ink car-

tridge etc.).
2. Turn ON the computer.
3. Turn ON the printer.
4. Connect the printer’s USB cable to one of the USB ports on the computer.
5. Windows will identify the printer and either load one of its own drivers or ask you 

to supply one. Follow the on-screen instructions.

Parallel Printer
This is still a very common type of printer. The install instructions are in the sidebar,
however you will need to purchase a parallel to USB converter.

Parallel Printer

After setting up the print-
er attach the parallel ca-
ble to the printer.

Connect the printer’s
parallel cable to the Par-
allel to USB converter,
and then plug the con-
verter into the USB port.

Turn ON the printer,
then turn ON the com-
puter.

Windows will identify the
printer and either load
one of its own drivers or
ask you to supply one.
Follow the on-screen in-
structions.
2 - 10 Adding a Printer
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Chapter 3: Power Management
Overview
To conserve power, especially when using the battery, your computer power man-
agement conserves power by controlling individual components of the computer
(the monitor and hard disk drive) or the whole system. This chapter covers:

• The Power Sources
• Turning on the Computer
• Power Schemes
• System Power Options
• Configuring the Power Button
• Battery Information

Advanced Configuration and Power Interface
The ACPI interface provides the computer with enhanced power saving techniques
and gives the operating system (OS) direct control over the power and thermal states
of devices and processors. For example, it enables the OS to set devices into low-
power states based on user settings and information from applications. ACPI is fully
supported in Windows XP.

OS Note

Power management
functions will vary slight-
ly depending on your
operating system. For
more information it is
best to refer to the user’s
manual of your operat-
ing system. 

(Note: All pictures used
on the following pages
are from the Windows
XP OS.)
Overview 3 - 1
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The Power Sources
The computer can be powered by either an AC/DC adapter or a battery pack.

AC/DC Adapter
Use only the AC/DC adapter that comes with your computer. The wrong type of AC/
DC adapter will damage the computer and its components.

1. Attach the AC/DC adapter to the DC-in jack on the left of the computer.
2. Plug the AC power cord into an outlet, and then connect the AC power cord to the 

AC/DC adapter.
3. Raise the lid/LCD to a comfortable viewing angle.
4. Press the power button to turn “On”.

Battery
The battery allows you to use your computer while you are on the road or when an
electrical outlet is unavailable. Battery life varies depending on the applications and
the configuration you're using. To increase battery life, let the battery discharge
completely before recharging (see “How do I completely discharge the battery?”
on page 3 - 12).

We recommend that you do not remove the battery. For more information on the bat-
tery, please refer to “Battery Information” on page 3 - 9.
3 - 2 The Power Sources
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Turning on the Computer
Now you are ready to begin using your computer. To turn it on simply press the pow-
er button on the front panel.

When the computer is on, you can use the power button as a Stand by/Hibernate/
Shutdown hot-key button when it is pressed for less than 4 seconds (pressing and
holding the power button for longer than this will shut the computer down). Use
Power Options in the Windows control panel to configure this feature.

Shutdown

Note that you should al-
ways shut your comput-
er down by choosing the
Turn Off Computer
command from the Start
menu in Windows. This
will help prevent hard
disk or system prob-
lems.

Forced Off

If the system “hangs”, and the Ctrl + Alt + Del key combination doesn’t work, press the pow-
er button for 4 seconds, or longer, to force the system to turn itself off.

Power Button as Stand by or Hibernate Button

If you are using a fully ACPI-compliant OS, (such as Windows XP) you can use the OS’s
“Power Options” control panel to set the power button to send the system into Stand by or
Hibernate mode (see your OS’s documentation, or “Configuring the Power Button” on
page 3 - 8 for details).
Turning on the Computer 3 - 3
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Power Schemes
You can set your computer to conserve power through individual components by
means of Power Schemes. You can also adjust the settings for each scheme to set
the monitor to turn off after a specified time, and the computer's hard disk motor to
turn off if the hard disk drive has not been accessed for a specified period of time (if
the system reads or writes data, the hard disk motor will be turned back on). The
schemes may also be set to set a specified time for the system to enter Stand by or
Hibernate modes (see “System Power Options” on page 3 - 6).

Resuming 
Operation

Press a key on the key-
board, or move the
mouse/TouchPad to re-
sume from Monitor or
Hard Disk Stand by.

Figure 3 - 1
Power Schemes
3 - 4 Power Schemes
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Each Windows Power Scheme will also adjust the processor performance of your
machine in order to save power. This is worth bearing in mind if you are experienc-
ing any reduced performance (especially under DC/battery power).

Choose the Home/Office Desk scheme for maximum performance when the com-
puter is powered from an AC power source. Choose the Max Battery scheme (bear
in mind that this scheme may slow down the overall performance of the computer in
order to save power) for maximum power saving when the computer is battery (DC
power) powered. Windows will use Portable/Laptop as the default scheme.
Power Schemes 3 - 5
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System Power Options
You can use the system power options to stop the computer’s operation and restart
where you left off. This system features Stand by and Hibernate sleep mode levels
(Hibernate mode will need to be enabled by clicking the option in the Hibernate
tab in the Power Options control panel - see Figure 3 - 2 on page 3 - 7).

Hibernate Mode vs. Shutdown
Hibernate mode and Shutdown are the same in that the system is off and you need
to press the power button to turn it on. Their main difference is:

When you come back from hibernation, you can return to where you last left off
(what was on your desktop) without reopening the application(s) and file(s) you last
used.

You can use either method depending on your needs. 

Stand by Mode vs. Hibernate Mode
If you want to stay away from your work for just a while, you can put the system on
Stand by instead of in hibernation. It takes a longer time to wake up the system from
Hibernate mode than from Stand by mode.

Stand by/Hibernate 
or Shutdown Error

The computer may stop
responding when you
put it into (or resume
from) Stand By or Hiber-
nate, or when you shut
down.

This error is caused by
power management
within Windows XP,
when applied to a PC
Camera attached to the
internal USB hub.

Microsoft has posted a
Hotfix for this error on its
website (search for Hot-
fix KB909667). 

Download and install the
Hotfix to correct this er-
ror.
3 - 6 System Power Options
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Stand by
Stand by saves the least amount of power, but takes the shortest time to return to full
operation. During Stand by the hard disk is turned off, and the CPU is made to idle
at its slowest speed. All open applications are retained in memory. When you are not
using your computer for a certain length of time, which you specify in the operating
system, it will enter Stand by mode to save power. 

Hibernate
Hibernate uses no power and saves all of your information on a part of the HDD be-
fore it turns the system off. Although it saves the most power it takes the longest time
to return to full operation. You can set your computer to automatically enter Hiber-
nate mode when the battery power is almost depleted. You will need to enable Hi-
bernate mode from the Hibernate tab in the Power Options control panel. The
system will resume from Hibernate mode by pressing the power button.

System Resume

The system can resume
from Stand by mode by:

• Pressing the power
button

• Pressing the Sleep/
Resume key combi-
nation

• An incoming call
received on the
modem (if enabled)

• Network card (Wake
On LAN) activity (if
enabled)

Figure 3 - 2
Enable Hibernation
System Power Options 3 - 7
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Configuring the Power Button
The power button may be set to send the computer in to either Stand by or Hiber-
nate mode. In Stand by mode, the LED  will blink green. In Hibernate mode
the LED will be off (battery) or orange (AC/DC adapter). If you are in a power sav-
ing mode set to save power through individual components (e.g. hard disk, monitor),
the LED will remain green.

Sleep Button

You may also configure
the Sleep/Resume key
combination (Fn + F4)
from the menu illustrat-
ed. In Windows this is
referred to as the Sleep
button.

Figure 3 - 3
Power Options

(Advanced - Power 
Buttons)

(Sleep) Button
Power Button Sleep/ResumeLid
3 - 8 Configuring the Power Button
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Battery Information
Please follow these simple guidelines to get the best use out of your battery.

New Battery
Always completely discharge, then fully charge, a new battery (see “Battery FAQ”
on page 3 - 12 for instructions on how to do this).

Battery Life
Your computer’s battery life is dependent upon many factors, including the pro-
grams you are running, and peripheral devices attached. Power Options (you may
set low battery Alarms and actions, and check the Power Meter from the Power
Options control panel), and settings in the OS will help prolong the battery life if
configured appropriately.

Low Battery 
Warning

When the battery is criti-
cally low, immediately
connect the AC/DC
adapter to the computer
or save your work, oth-
erwise, the unsaved
data will be lost when
the power is depleted.

Figure 3 - 4
Power Options 
(Alarm & Power 

Meter)
Battery Information 3 - 9
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Battery life may be shortened through improper maintenance. To optimize the life
and improve its performance, fully discharge and recharge the battery at least
once every 30 days.

We recommend that you do not remove the battery yourself. If you need to remove
the battery for any reason, see “Removing the Battery” on page 6 - 3.

Recharging the Battery with the AC/DC Adapter
The battery pack automatically recharges when the AC/DC adapter is attached and
plugged into an electrical outlet. If the computer is powered on, and in use, it will
take several hours to fully recharge the battery. When the computer is turned off but
plugged into an electrical outlet, battery charge time is less. (Refer to Table 1 - 3, on
page 1 - 11 for information on the battery charge status, and to “Battery Informa-
tion” on page 3 - 9 for more information on how to maintain and properly recharge
the battery pack.)

Conserving Battery 
Power

To conserve battery power:

Lower the brightness level
of the LCD display. The
system will decrease LCD
brightness slightly to save
power when it is not pow-
ered by the AC/DC adapt-
er.

Close modem or communi-
cation applications when
they are not being used.

Remove any unused PC
Cards from the computer
(PC Cards quickly use up
battery power even if the
system enters sleep
mode).

Disconnect any unneces-
sary external devices.
3 - 10 Battery Information
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Proper handling of the Battery Pack
• DO NOT disassemble the battery pack under any circumstances
• DO NOT expose the battery to fire or high temperatures, it may explode
• DO NOT connect the metal terminals (+, -) to each other

Damaged Battery Warning

Should you notice any physical defects (e.g. the battery is bent out of shape after being
dropped), or any unusual smells emanating from the notebook battery, shut your computer
down immediately and contact your service center. If the battery has been dropped we do
not recommend using it any further, as even if the computer continues to work with a dam-
aged battery in place, it may cause circuit damage, which may possibly result in fire. It is
recommended that you replace your computer battery every two years.
Battery Information 3 - 11
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Battery FAQ
How do I completely discharge the battery?
Use the computer with battery power until it shuts down due to a low battery. Don’t
turn off the computer by yourself even when you see a message that indicates the
battery is critically low, just let the computer use up all of the battery power and shut
down on its own. Disable the Power Options functions in the Control Panel, espe-
cially any Alarms (unclick the tickboxes - see page 3 - 9) and Schemes (change all
the settings to Never - see page 3 - 4). As the battery nears the end of its life save
and close any critical files.

How do I fully charge the battery?
When charging the battery, don’t stop until the LED charging indicator light changes
from orange to green.

How do I maintain the battery?
Completely discharge and charge the battery at least once every 30 days or after
about 20 partial discharges.

Caution

Danger of explosion if
battery is incorrectly re-
placed.

Replace only with the
same or equivalent type
recommended by the
manufacturer. Discard
used battery according
to the manufacturer’s in-
structions.
3 - 12 Battery Information
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Chapter 4: Drivers & Utilities
This chapter deals with installing the drivers and utili-
ties essential to the operation or improvement of some
of the computer’s subsystems. The system takes ad-
vantage of some newer hardware components for
which the latest versions of most available operating
systems haven’t built in drivers and utilities. Thus,
some of the system components won’t be auto-config-
ured with an appropriate driver or utility during oper-
ating system installation. Instead, you need to
manually install some system-required drivers and
utilities. 

What to Install
The Device Drivers & Utilities + User’s Manual disc
contains the drivers and utilities necessary for the
proper operation of the computer. 

Table 4 - 1, on page 4 - 3 lists what you need to install
and it is very important that the drivers are in-
stalled in the order indicated.

See “Windows 7 Information” on page D - 1 for in-
formation on installing drivers for the Windows 7 OS.

Module Driver Installation
The procedures for installing drivers for the Wireless
LAN, PC Camera and 3.75G/HSPA modules are
provided in “Modules & Options” on page 7 - 1.

Make sure any modules (e.g. PC Camera, WLAN or
3.75G/HSPA) are ON before installing the appropriate
driver.
What to Install 4 - 1
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Driver Installation
Insert the Device Drivers & Utilities + User’s Manual
disc and click Install Drivers/Option Drivers (button).

Follow the instructions to install the driver. Alterna-
tively click Start, navigate (Browse..) to the execut-
able file and then follow the manual setup instructions.

Figure 4 - 1 - Drivers Installer Screen 1

1. Check the driver installation order from Table 4 - 1, 
on page 4 - 3 (the drivers must be installed in 
this order) which is the same as that listed in the 
Drivers Installer menu below.

2. Click to select the driver you wish to install, after 
installing each driver it will become grayed out (if 
you need to reinstall any driver, click the Unlock 
button).

3. Follow the instructions for each individual driver 
installation procedure as listed on the following 
pages.

 
Figure 4 - 2 - Drivers Installer Screen 2
4 - 2 Driver Installation
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Table 4 - 1 - Driver Installation

Manual Driver Installation
Click Browse CD (button) in the Drivers Installer ap-
plication and browse to the executable file in the ap-
propriate driver folder.

Driver - Windows 7 Page #

Chipset Page 4 - 5

Video Page 4 - 5

Audio Page 4 - 5

LAN Page 4 - 5

TouchPad Page 4 - 5

Card Reader Page 4 - 5

Hot Key Page 4 - 6

PC Camera Module Page 7 - 7

Wireless LAN Module Page 7 - 17

3.75G/HSPA Module Page 7 - 18

Windows XP Service Pack 3

Make sure you install Windows XP Service Pack 3 (or
a Windows XP version which includes Service Pack 3)
before installing any drivers.

External Optical (CD/DVD) Device Drives

To install applications and drivers etc. you will need to
attach an external optical CD/DVD device to the USB
ports. If you are having problems detecting external
ODDs, enable the enhanced detection of these devic-
es see “Enhance USB ODD detection (Advanced
Menu)” on page 5 - 10.
Driver Installation 4 - 3
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Authorized Driver Message
If you receive a message telling you that the driver you
are installing is not authorized (Digital Signature Not
Found), just click Yes or Continue Anyway to ignore
the message and continue the installation procedure.

You will receive this message in cases where the driv-
er has been released after the version of Windows you
are currently using. All the drivers provided will have
already received certification for Windows.

New Hardware Found
If you see the message “New Hardware Found”
(Found New Hardware Wizard) during the installa-
tion procedure (other than when outlined in the driver
install procedure), click Cancel to close the window,
and follow the installation procedure as directed.

Version Conflict Message
During driver installation if you encounter any “file
version conflict” message, please click Yes to choose
to keep the existing (newer) version.

Updating/Reinstalling Individual Drivers
If you wish to update/reinstall individual drivers it
may be necessary to uninstall the original driver.To do
this go to the Control Panel in the Windows OS and
double-click the Add/Remove Programs item. If you
see the individual driver listed (if not see below), un-
install it, following the on screen prompts (it may be
necessary to restart the computer). Go to the appropri-
ate section of the manual to complete the update/rein-
stall procedure for the driver in question.

If the driver is not listed in the Add/Remove Pro-
grams item:
1. Click Start (menu), point to Settings and click Con-

trol Panel (or click Start > Control Panel). 
2. Double-click System (icon); System (icon) is in 

Performance and Maintenance (category).
3. Click Hardware (tab) > Device Manager (button).
4. Double-click the device you wish to update/reinstall 

the driver for (you may need to click “+”).
5. Look for the Update Driver button (check the 

Driver tab) and follow the on screen prompts.
4 - 4 Driver Installation
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Driver Installation Procedure
Insert the Device Drivers & Utilities + User’s Manual
disc and click Install Drivers (button), or click Option
Drivers (button) to access the optional driver menu.

Chipset
1. Click 1.Install Chipset Driver > Yes.
2. Click Next > Yes > Next > Next.
3. Click Finish to restart the computer.

Video
1. Click 2.Install Video Driver > Yes.
2. Click Next > Yes > Next > Next.
3. Click Finish to restart the computer.

Audio
1. Click 3.Install Audio Driver > Yes. 
2. Click Next > Yes.
3. Click Finish to restart the computer.

LAN
1. Click 4.Install LAN Driver > Yes. 
2. Click Install > Finish to complete the installa-

tion.
3. The network settings can now be configured.

TouchPad
1. Click 5.Install Touch Pad Driver > Yes.
2. Select the installation language and click OK.
3. Click Next.
4. Click Finish > Yes to restart the computer.

Card Reader
1. Click 6.Install Cardreader Driver > Yes.
2. Click Install > Finish to complete the installa-

tion.

Driver Installation General Guidelines

As a general guide follow the default on screen instruc-
tions for each driver (e.g. Next > Next > Finish) unless
you are an advanced user. In many cases a restart is
required to install the driver.
Driver Installation 4 - 5
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Hot Key
1. Click 7.Install HotKey Driver > Yes. 
2. Click Next > Install.
3. Click Finish > Finish to restart the computer.

Optional Drivers
See the pages indicated overleaf for the driver installa-
tion procedures for any modules included in your pur-
chase option.

Figure 4 - 3 - Drivers Installer - Option Drivers Menu

Bluetooth Module
Note: The operating system is the default setting for
Bluetooth control in Windows XP, and does not re-
quire a driver. See “Bluetooth Module” on page 7 -
2 for configuration instructions.

PC Camera Module
See the introduction in “PC Camera Module” on
page 7 - 7, and check the installation procedure.

Wireless LAN Module
See the introduction in “Wireless LAN Module” on
page 7 - 14, and check the installation procedure.

3.75G/HSPA Module
See the introduction in “3.75G/HSPA Module” on
page 7 - 18, and check the installation procedure.
4 - 6 Driver Installation
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Chapter 5: BIOS Utilities
Overview
This chapter gives a brief introduction to the computer’s built-in software: 

Diagnostics: The POST (Power-On Self Test)

Configuration: The Phoenix TrustedCore Setup Utility
If your computer has never been set up, or you are making important changes to the
system (e.g. hard disk setup), then you should review this chapter first and note the
original settings found in Setup. Even if you are a beginner, keep a record of the set-
tings you find and any changes you make. This information could be useful if your
system ever needs servicing.

There is one general rule: Don’t make any changes unless you are sure of what you
are doing. Many of the settings are required by the system, and changing them could
cause it to become unstable or worse. If you have any doubts, consult your service
representative.

BIOS Screens

Note that the BIOS
screens pictured on
these pages are intend-
ed for guidance in set-
ting up your system’s
BIOS.

BIOS versions are sub-
ject to constant change
and revision, therefore
your computer’s actual
screens may appear
slightly different from
those pictured on these
pages.  
Overview 5 - 1
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The Power-On Self Test (POST)
Each time you turn on the computer, the system takes a few seconds to conduct a
POST, including a quick test of the on-board RAM (memory).

As the POST proceeds, the computer will tell you if there is anything wrong. If there
is a problem that prevents the system from booting, it will display a system summary
and prompt you to run Setup. 

If there are no problems, the Setup prompt will disappear and the system will load
the operating system. Once that starts, you can’t get into Setup without rebooting.

POST Screen

1.BIOS information
2.CPU type 
3.Memory status
4.Enter Setup prompt

appears only during
POST

Note: The POST screen
as pictured right is for
guideline purposes only.
The POST screen on
your computer may ap-
pear slightly different. If
you disable the Boot-
time Diagnostic Screen,
the POST screen will not
appear.

Figure 5 - 1
POST Screen

Phoenix TrustedCore(tm) NB

Copyright 1985-2006 Phoenix Technologies Ltd.

All Rights Reserved

Bios Revision: ********

KBC/EC Firmware Revision: ********

CPU = 1 Processors Detected

Intel(R) Atom(TM) CPU N270 @ 1.60GHz

1015M System RAM Passed

512 KB L2 Cache

System BIOS shadowed

Video BIOS shadowed

Fixed Disk 0: FUJITSU MHY2120BH

Mouse intialized

Press <F2> to enter SETUP

1

2
3

4

5 - 2 The Power-On Self Test (POST)
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Failing the POST
Errors can be detected during the POST. There are two categories, “fatal” and “non-
fatal”.

Fatal Errors
These stop the boot process and usually indicate there is something seriously wrong
with your system. Take the computer to your service representative or authorized
service center as soon as possible.

Non-Fatal Errors
This kind of error still allows you to boot. You will get a message identifying the
problem (make a note of this message!) followed by the prompt:

• Press <F1> to resume
• <F2> to enter Setup 

Press F1 to see if the boot process can continue. It may work, without the correct
configuration. 

Press F2 to run the Setup program and try to correct the problem. If you still get an
error message after you change the setting, or if the “cure” seems even worse, call
for help.
The Power-On Self Test (POST) 5 - 3
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The Setup Utility
The Phoenix TrustedCore Setup Utility tells the system how to configure itself
and manage basic features and subsystems (e.g. port configuration).

Entering Setup
To enter Setup, turn on the computer and press F2 during the POST. The prompt
(Press F2 to Enter Setup) seen on page 5 - 2 is usually present for a few seconds
after you turn on the system. If you get a “Keyboard Error”, (usually because you
pressed F2 too quickly) just press F2 again.

If the computer is already on, reboot using the Ctrl + Alt + Delete combination and
then hold down F2 when prompted. The Setup main menu will appear.

BIOS Settings 
Warning

Incorrect settings can
cause your system to
malfunction. To correct
mistakes, return to Set-
up and restore the Set-
up Defaults with <F9>.
5 - 4 The Setup Utility
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Setup Screens
The following pages contain additional advice on portions of the Phoenix Trusted-
Core Setup Utility.

Along the top of the screen is a menu bar with menu headings. When you select a
heading, a new screen appears. Scroll through the features listed on each screen to
make changes to Phoenix TrustedCore Setup Utility.

Instructions on how to navigate each screen are in the box along the bottom of the
screen. If these tools are confusing, press F1 to call up a General Help screen, and
then use the arrow keys to scroll up or down the page.

The Item Specific Help on the right side of each screen explains the highlighted
item and has useful messages about its options.

If you see an arrow  next to an item, press Enter to go to a sub-menu on that sub-
ject. The sub-menu screen that appears has a similar layout, but the Enter key may
execute a command.

Setup Menus

The Setup menus
shown in this section are
for reference only. Your
computer’s menus will
indicate the configura-
tion appropriate for your
model and options.
The Setup Utility 5 - 5
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Main Menu

System Time & Date (Main Menu)
The hour setting uses the 24-hour system (i.e., ØØ = midnight; 13 = 1 pm). If you
can change the date and time settings in your operating system, you will also change
these settings. Some applications may also alter data files to reflect these changes.

Figure 5 - 2
Main Menu

Main Advanced Security Boot Exit

F1 Help �� Select Item -/+ Change Values F9 Setup Defaults

Esc Exit �� Select Menu Enter Select �Sub-Menu F10 Save and Exit

Item Specific Help

<Tab>, <Shift Tab>, or

<Enter> selects field.

Main

System Time: [22:12:05]

System Date: [02/18/2009]

�SATA Port 1 [FUJITSU MHV2120BH-(S]

System Memory 640 KB

Extended Memory 1014 MB

BIOS Revision ********

KBC/EC Firmware Revision ********

Phoenix TrustedCore(tm) Setup Utility
5 - 6 Main Menu
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SATA Port 1 (Main Menu)
Pressing Enter opens the sub-menu to show the configuration of a HDD on the com-
puter’s Serial ATA Port 1. Use the Auto (Type:) setting to have the items configured
automatically for you.

System/Extended Memory (Main Menu)
This item contains information on the system memory, and is not user configurable.
The system will auto detect the amount of memory installed.
Main Menu 5 - 7
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Advanced Menu

Installed O/S (Advanced Menu)
This setting tells the computer what kind of operating system you’re using. Make
sure you choose the correct setting for your O/S in order to prevent system problems.
Note: If you select the Vista/Win 7 O/S then the SATA Mode Selection menu will
become available. If you are installing the Windows XP O/S make sure you have set
the appropriate operating system here in order to prevent system problems.

Figure 5 - 3
Advanced Menu

Main AAdvanced Security Boot Exit

F1 Help �� Select Item -/+ Change Values F9 Setup Defaults

Esc Exit �� Select Menu Enter Select �Sub-Menu F10 Save and Exit

Item Specific Help

Advanced

Select the operating

system installed

on your system which

you will use most

commonly.

Note: An incorrect

setting can cause

some operating

systems to display

unexpected behavior.

Phoenix TrustedCore(tm) Setup Utility

Installed O/S: [VISTA / Win 7]

SATA Mode Selection: [AHCI]

Legacy USB Support: [Enabled]

Boot-time Diagnostic Screen: [Disabled]

Reset Configuration Data: [No]

Power On Boot Beep [Disabled]

Battery Low Alarm Beep [Enabled]

Detect External CRT [Enabled]

Enhance USB ODD detection [Disabled]

Only available if Windows Vista/Win 7
is selected as the O/S.
5 - 8 Advanced Menu
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SATA Mode Selection (Advanced Menu)
This menu is only available if you select the Vista/Win 7 O/S as your operating sys-
tem. You can configure SATA (Serial ATA) control to operate in either IDE (native/
compatible) or AHCI (Advanced Host Controller Interface) modes from this menu.
The SATA mode should be set to AHCI mode for this system (unless you are sure
your hard disk can only operate in IDE mode). If you are unsure of the mode your
hard disk supports contact your service center.

Legacy USB Support (Advanced Menu)
Use this menu item to enable/disable the support for Legacy Universal Serial Bus in
non-USB aware operating systems.

Boot-time Diagnostic Screen (Advanced Menu)
Use this menu item to enable/disable the Boot-time Diagnostic Screen or POST
screen (see “The Power-On Self Test (POST)” on page 5 - 2).

Reset Configuration Data (Advanced Menu)
This item is set to No as default. You can change the setting to Yes if you have in-
stalled a new add-on which has reconfigured the system, resulting in such a serious
system conflict that the operating system is unable to boot.

SATA Mode 
Selection

If you have installed the
Windows Vista/ Win-
dows 7 operating sys-
tem with AHCI mode
enabled (default set-
ting), DO NOT disable
AHCI mode (if you wish
to disable AHCI mode
you will need to reinstall
the Windows Vista/
Windows 7 OS).
Advanced Menu 5 - 9
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Power On Boot Beep (Advanced Menu)
Use this menu item to enable/disable the beep as the computer starts up.

Battery Low Alarm Beep (Advanced Menu)
Use this menu item to enable/disable the audible warning when the battery has
reached low power status.

Detect External CRT (Advanced Menu)
This menu allows you to Enable/Disable detection for External CRT’s (external
displays). You can disable detection to save system power.

Enhance USB ODD detection (Advanced Menu)
This menu allows you to Enable/Disable enhanced detection for External USB
ODD (optical device drives e.g. DVD drives). You can disable detection to speed up
boot time, or enable it if you are having problems with detecting any attached USB
ODDs.
5 - 10 Advanced Menu



BIOS Utilities

5

Security Menu

Set Supervisor Password (Security Menu)
You can set a password for access to the Phoenix TrustedCore Setup Utility. This
will not affect access to the computer OS (only the Phoenix TrustedCore Setup
Utility).

Security Menu

The changes you
make here affect the
access to the Setup
utility itself, and also
access to your ma-
chine as it boots up af-
ter you turn it on.
These settings do not
affect your machine or
network passwords
which will be set in
your software OS.

Figure 5 - 4
Security Menu

Main Advanced SSeeccuurriittyy Boot Exit

F1 Help �� Select Item -/+ Change Values F9 Setup Defaults

Esc Exit �� Select Menu Enter Select �Sub-Menu F10 Save and Exit

Item Specific Help

Supervisor Password

controls access to the

setup utility.

Security
=

Supervisor Password Is: Clear

User Password Is: Clear

Set Supervisor Password [Enter]

Set User Password [Enter]

Password on boot: [Disabled]

Fixed disk boot sector: [Normal]

Phoenix TrustedCore(tm) Setup Utility
Security Menu 5 - 11
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Set User Password (Security Menu)
You can set a password for user mode access to the Phoenix SecureCore Setup
Utility. This will not affect access to the computer OS, (only the Setup utility) unless
you choose to set a Password on Boot (see below). Many menu items in the Phoenix
SecureCore Setup Utility cannot be modified in user mode. You can only set the
user password after you have set the supervisor password.

Password on boot (Security Menu)
Specify whether or not a password should be entered to boot the computer (you may
only set a password on boot if a supervisor password is enabled). If “Enabled”
is selected, only users who enter a correct password can boot the system (see the
warning in the sidebar). The default setting is “Disabled”. 

Fixed disk boot sector (Security Menu)
If you choose “Write-Protect” this will protect against viruses being written to the
hard disk boot sector (this is not a substitute for installing an anti-virus program - see
“Viruses” on page 8 - 4).

Note: To clear existing passwords press Enter and type the existing password, then
press Enter for the new password (without typing any password entry) and Enter
again to confirm the password clearance.

Password Warning

If you set a boot pass-
word (Password on boot
is “Enabled“), NEVER
forget your password. 

The consequences of
this could be serious. If
you cannot remember
your boot password you
must contact your ven-
dor and you may lose all
of the information on
your hard disk.
5 - 12 Security Menu
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Boot Menu

When you turn the computer on it will look for an operating system (e.g. Windows
Vista) from the devices listed in this menu, and in this priority order. If it cannot
find the operating system on that device, it will try to load it from the next device in
the order specified in the Boot priority order. Item specific help on the right is
available to help you move devices up and down the order.

BIOS Screens

Note that the BIOS
screens pictured on
these pages are intend-
ed for guidance in set-
ting up your system’s
BIOS.

BIOS versions are sub-
ject to constant change
and revision, therefore
your computer’s actual
screens may appear
slightly different from
those pictured on these
pages.  

Figure 5 - 5
Boot Menu

Phoenix TrustedCore(tm) Setup Utility

F1 Help �� Select Item -/+ Change Values F9 Setup Defaults

Esc Exit �� Select Menu Enter Select �Sub-Menu F10 Save and Exit

Item Specific Help

Keys used to view or

configure devices:

Up and Down arrows

select a device.

<+> and <-> moves

the device up or down.

<x> exclude or include

the device to boot.

<Shift + 1> enables or

disables a device.

Boot priority order:
1: IDE HDD: FUJITSU MHY212BH-(S1)
2: USB KEY:
3: USB FDC:
4: USB CDROM:
5: USB HDD:
6: PCI BEV: KMC26X Fast Ethernet Contr
7:
8:

Excluded from boot order:
: USB ZIP:

Main Advanced Security Boot Exit
Boot Menu 5 - 13
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Exit Menu

Choosing to Discard Changes, or Exit Discarding Changes, will wipe out any
changes you have made to the Setup. You can also choose to restore the original Set-
up defaults that will return the Setup to its original state, and erase any previous
changes you have made in a previous session.

Figure 5 - 6
Exit Menu

F1 Help �� Select Item -/+ Change Values F9 Setup Defaults

Esc Exit �� Select Menu Enter Select �Sub-Menu F10 Save and Exit

Item Specific Help

Exit System Setup and

save your changes to

CMOS.

Exit Saving Changes

Exit Discarding Changes

Load Setup Defaults

Discard Changes

Save Changes

Main Advanced Security Boot Exit

Phoenix TrustedCore(tm) Setup Utility
5 - 14 Exit Menu
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Chapter 6: Upgrading The Computer
Overview
This chapter contains information on upgrading the computer. Follow the steps out-
lined to make the desired upgrades. If you have any trouble or problems you can con-
tact your service representative for further help. Before you begin you will need:

• A small crosshead or Phillips screwdriver
• A small regular slotted (flathead) screwdriver
• An antistatic wrist strap

Before working with the internal components you will need to wear an antistatic
wrist strap to ground yourself because static electricity may damage the compo-
nents.

The chapter includes:

• Removing the Battery
• Upgrading the HDD
• Upgrading the System Memory (RAM)

Please make sure that you review each procedure before you perform it.

Warranty Warning

Please check with your
service representative
before undertaking any
upgrade procedures to
find out if this will VOID
your warranty.
Overview 6 - 1
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When Not to Upgrade
These procedures involve opening the system’s case, adding and sometimes replac-
ing parts.

You should not perform any of these upgrades if:

• Your system is still under warranty or a service contract
• You don’t have all the necessary equipment 
• You’re not in the correct environment
• You doubt your abilities

Under any of these conditions, contact your service representative to purchase or re-
place the component(s).

Power Safety 
Warning

Before you undertake
any upgrade proce-
dures, make sure that
you have turned off the
power, and disconnect-
ed all peripherals and
cables (including tele-
phone lines). It is advis-
able to also remove your
battery in order to pre-
vent accidentally turning
the machine on.

Removal Warning

When removing any cover(s) and screw(s) for the purposes of device upgrade, remember
to replace the cover(s) and screw(s) before turning the computer on.
6 - 2 Overview
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Removing the Battery
If you are confident in undertaking upgrade procedures yourself, for safety reasons
it is best to remove the battery.
1. Turn the computer off, and turn it over.
2. Slide the latches  in the direction of the arrows to unlock the battery.
3. Slide the battery out in the direction of the arrow .

Warranty Warning

Please check with your
service representative
before undertaking any
upgrade procedures to
find out if this will VOID
your warranty.

Figure 6 - 1
Battery Removal

1
2

2

1 1
Removing the Battery 6 - 3
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Upgrading the HDD
The hard disk drive can be taken out to accommodate other 2.5" serial (SATA)
HDDs with a height of 9.5mm (h) and a speed of 5400 RPM or lower. Follow your
operating system’s installation instructions, and install all necessary drivers and util-
ities (see “Driver Installation” on page 4 - 2), when setting up a new hard disk.

The procedure for hard disk removal differs from Model A to Model B computers: 

• See “Hard Disk Removal - Model A Computers” on page 6 - 5.
• See “Hard Disk Removal - Model B Computers” on page 6 - 8.

HDD System 
Warning

New HDDs are blank. Be-
fore you begin make sure:
You have backed up any
data you want to keep from
your old drive.
You have all the CDs/DVDs
required to install your op-
erating system and pro-
grams.
If you have access to the in-
ternet, download the latest
application and hardware
driver updates for the oper-
ating system you plan to in-
stall. Copy these to a
removable medium.

Figure 6 - 2
Keyboard Release
6 - 4 Upgrading the HDD
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Hard Disk Removal - Model A Computers
1. Turn off the computer, and remove the battery.
2. Carefully press in the three keyboard latches (  - ) at the top of the keyboard 

to elevate the keyboard from its normal position (you will need to use a small 
screwdriver to do this).

3. Carefully lift the keyboard  up (do not bend the keyboard ribbon cable ).

Hard Disk Drive 
Speeds

If you are going to up-
grade/replace the hard
disk drive, note that It is
recommended that
HDDs of a maximum
speed of 5400 RPM are
used. DO NOT use
7200rpm or higher
HDDs. 

Figure 6 - 3
Keyboard Release 

(Model A 
Computers)

1 3

54 55

321

5

4
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4. Remove screw  and then use a screwdriver to push out the hard disk bay cover 
 at the point  indicated in Figure 6 - 4.

5. Use a screwdriver to push the hard disk out of the bay at point  (Figure 6 - 5). 

6
7 8

Figure 6 - 4
HDD Bay Cover 

Removal
(Model A 

Computers)

Figure 6 - 5
HDD Removal

(Model A 
Computers)

3 7

6

Push the 8
cover out here

9

9
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6. Carefully insert the hard disk into the bay until it is firmly connected (orientate the 
hard disk as illustrated in Figure 6 - 6; don’t force it as it only fits one way).

7. Insert the cover as illustrated in Figure 6 - 7 and secure the cover with the screw 
at point .

8. Secure the keyboard, replace the battery and restart the computer to allow the 
system to detect the hard disk drive.

Figure 6 - 6
HDD Insertion

(Model A 
Computers)

Figure 6 - 7
HDD Bay Cover 

Insertion
(Model A 

Computers)

10

Re-Inserting the Keyboard

When re-inserting the keyboard
firstly align the three keyboard
tabs at the bottom of the keyboard
with the slots in the case.

10
Upgrading the HDD 6 - 7
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Hard Disk Removal - Model B Computers
1. Turn off the computer, and remove the battery.
2. Locate the hard disk bay cover and remove screw .
3. Slide the hard disk assembly in the direction of the arrow .
4. Carefully lift the hard disk assembly  up out of the bay.

Hard Disk Drive 
Speeds

If you are going to up-
grade/replace the hard
disk drive, note that It is
recommended that
HDDs of a maximum
speed of 5400 RPM are
used. DO NOT use
7200rpm or higher
HDDs. 

Figure 6 - 8
Hard Disk Assembly 

Removal 
(Model B 

Computers)

1
2
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5. Remove screws  -  from the hard disk assembly.
6. Separate the hard disk from the case.
7. Insert the new hard disk into the case and pay careful attention to the disk’s 

orientation in the case.
8. Secure the disk with the four screws and then reinsert the hard disk assembly into 

the computer’s hard disk bay.
9. Replace the hard disk bay screw (see Figure 6 - 8 on page 6 - 8).

54 57

Figure 6 - 9
HDD Removal

(Model B 
Computers)

6

5

4

7
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Upgrading the System Memory (RAM)
The computer has one memory socket for 200 pin Small Outline Dual In-line (SO-
DIMM) DDRII (DDR2) type memory modules (see “Memory” on page C - 2 for
details of supported module types).

The total memory size is automatically detected by the POST routine once you turn
on your computer.

1. Turn off the computer, and remove the battery.
2. Carefully press in the three keyboard latches (  - ) at the top of the keyboard 

to elevate the keyboard from its normal position (you will need to use a small 
screwdriver to do this).

3. Carefully lift the keyboard  up (do not bend the keyboard ribbon cable ).

Figure 6 - 10
Keyboard Release

1 3
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4. Gently pull the two release latches on the sides of the memory socket in the 
direction indicated by the arrows (  & ) in Figure 6 - 11.

5. The RAM module will  pop-up, and you can remove it.

6 7

Figure 6 - 11
RAM Module 

Release Latches

Contact Warning

Be careful not to touch
the metal pins on the
module’s connecting
edge. Even the cleanest
hands have oils which
can attract particles, and
degrade the module’s
performance.

Figure 6 - 12
RAM Module 

Removal

76

8

8
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6. Insert a new module holding it at about a 30° angle and fit the connectors firmly 
into the memory slot.

7. The module’s pin alignment will allow it to only fit one way. Make sure the module 
is seated as far into the slot as it will go. DO NOT FORCE the module; it should fit 
without much pressure.

8. Press the module in and down towards the mainboard until the slot levers click into 
place to secure the module.

9. Secure the keyboard, replace the battery and restart the computer to allow the 
system to detect the hard disk drive.

10. Restart the computer to allow the BIOS to register the new memory configuration 
as it starts up.

Re-Inserting the 
Keyboard

When re-inserting the
keyboard firstly align the
three keyboard tabs at
the bottom of the key-
board with the slots in
the case.
6 - 12 Upgrading the System Memory (RAM)
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Upgrading the Processor
If you want to upgrade your computer by replacing the existing processor with a fast-
er/new one you will need to contact your customer service representative. We rec-
ommend that you do not do this yourself, since if it is done incorrectly you may
damage the processor or mainboard.

Warranty

The CPU is not a user
serviceable part. Ac-
cessing the CPU in any
way, may violate your
warranty.

Unauthorized tampering
with the HDD may also
violate your warranty.
Upgrading the Processor 6 - 13
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Chapter 7: Modules & Options
Overview
This chapter contains information on the following modules, which may come with
your computer, depending on the configuration purchased. If you are unsure please
contact your service representative.

• Bluetooth Module
• PC Camera Module
• Wireless LAN Module
• 3.75G/HSPA Module

Important Notice - 
3.75G/HSPA & Blue-
tooth/Wireless LAN 

Modules

In order to comply with
FCC regulations you
should NOT operate the
3.75G/HSPA module
and the Bluetooth/Wire-
less LAN modules at the
same time as this may
disrupt radio frequency,
and cause interference. 

When the 3.75G/HSPA
module is powered on,
make sure that the Blue-
tooth/Wireless LAN
modules are powered
off.

Driver Installation & Module Power

Make sure any modules (e.g. PC Camera, WLAN or 3.75G/HSPA modules are ON before
installing the appropriate driver).
Overview 7 - 1



Modules & Options

7

Bluetooth Module
The operating system’s Bluetooth Devices control panel is used to configure the
Bluetooth settings in Windows XP, and therefore does not require a driver. Use the
Fn + F12 key combination (see “Function/Hot Key Indicators” on page 1 - 9) to
toggle power to the Bluetooth module.

Wireless Device 
Operation Aboard 

Aircraft

The use of any portable
electronic transmission
devices aboard aircraft
is usually prohibited.
Make sure the mod-
ule(s) are OFF if you are
using the computer
aboard aircraft.

Use the Fn + F12 key
combination to toggle
power to the Bluetooth
module, and check the
LED indicator to see if
the module is powered
on or not (see Table 1 -
2, on page 1 - 9/
Table 1 - 3, on page 1 -
11).

Bluetooth Data Transfer

Note that the transfer of data between the computer and a Bluetooth enabled device is sup-
ported in one direction only (simultaneous data transfer is not supported). Therefore
if you are copying a file from your computer to a Bluetooth enabled device, you will not be
able to copy a file from the Bluetooth enabled device to your computer until the file transfer
process from the computer has been completed.

Bluetooth Module & Resuming From Sleep Mode

The Bluetooth module’s default state will be off after resuming from the Sleep power-saving
state. Use the key combination (Fn + F12) to power on the Bluetooth module after the com-
puter resumes from Sleep.
7 - 2 Bluetooth Module
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Bluetooth Local Area Connection Icon
If you want to display the Local Area Connection icon for the Bluetooth connection
in the taskbar, set it up as follows:

1. Access the Network Connections control panel in Windows (Start > Settings > 
Network Connections OR Start > Connect To > Show all Connections) or by 
clicking the taskbar icon .

2. Right-click the Bluetooth connection icon, and select Properties.
3. Click to put a tick (if none is present) in the “Show icon in the notification area 

when connected” box and click OK.
4. Close the control panels and the icon  for the Bluetooth local area connection 

will be displayed in the taskbar when connected (see sidebar and overleaf).

Figure 7 - 1
Local Area 
Connection
Bluetooth Module 7 - 3
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Bluetooth Configuration in Windows XP
Setup your Bluetooth Device so the Computer Can Find it
1. Turn your Bluetooth device (e.g. PDA, mobile phone etc.) on.
2. Make the device discoverable (to do this check your device documentation).

To Turn the Bluetooth Module On
1. Press the Fn + F12 key combination to power on the Bluetooth module. 
2. A Bluetooth icon  will appear in the taskbar (see sidebar).
3. You can then do any of the following to access the Bluetooth Devices control 

panel.

• Double-click the icon  to access the Bluetooth Devices control panel.
• Click Start, and click Control Panel (or point to Settings and click Control Panel), and then click Blue-

tooth Devices (Network and Internet Connections).
• Click/Right-click the icon  and choose an option from the menu.

Bluetooth Taskbar 
Icon

If you cannot see the
Bluetooth icon in the task-
bar, access the Blue-
tooth Devices control
panel. Click Options
(tab), and make sure that
Show Bluetooth icon in
the notification area
check box has a tick in-
side it.

Note that you will need to
check the LED indicator
to see if the module is
powered on or not.

Figure 7 - 2
Bluetooth Devices & 

Click Icon Menu
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To Add a Bluetooth Device
1. Access the Bluetooth Devices control panel.
2. Click Options (tab), and make sure that Allow Bluetooth devices to connect to 

this computer check box (Connections) has a tick inside it.
3. Click Devices (tab), and then click Add.
4. The Add Bluetooth Device Wizard will appear.
5. Click to select “My device is set up and ready to be found”, and then click Next.

6. The Wizard will then search for any available Bluetooth devices within range.
7. Click to select the device you want to communicate with, and click Next.
8. Select an appropriate passkey option and click Next.

9. Click Finish.

Figure 7 - 3
Add Bluetooth 
Device Wizard

Passkey Options

You can allow the sys-
tem to choose a pass-
key for you. You will
then be prompted to en-
ter the generated pass-
key on your Bluetooth
device.

Figure 7 - 4
Passkey Option
Bluetooth Module 7 - 5
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To Change Settings for the Bluetooth Device
1. Access the Bluetooth Devices control panel.
2. Click on the device you want to change and click Properties to:
• Change the name of the device (click General, type a new name and click OK).
• Enable/Disable a service (click Services, clear/tick the check box next to the service and click OK).

To Make your Computer Discoverable to Bluetooth Devices
1. Access the Bluetooth Devices control panel.
2. Click Options, and make sure that Turn discovery on check box (Discovery) 

has a tick inside it.
3. Make sure that Alert me when a new Bluetooth device wants to connect check 

box (Connections) has a tick inside it, if you want to be notified when a Bluetooth 
device wants to connect.

Bluetooth Module & 
Resuming From 

Sleep Mode

The Bluetooth module’s
default state will be off af-
ter resuming from the
Sleep power-saving
state. Use the key combi-
nation (Fn + F12) to pow-
er on the Bluetooth
module after the comput-
er resumes from Sleep.

Figure 7 - 5
Bluetooth Devices 

Options
7 - 6 Bluetooth Module
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PC Camera Module
There are a number of different camera modules available with this computer model
series. You will have the appropriate application automatically installed for your
camera from the Drivers Installer application. There are a number of different cam-
era modules available with this computer model series. You will have the appropri-
ate application installed for your camera. Make sure you access the application via
the WebCam desktop shortcut.

Use the Fn + F10 key combination (see “Function/Hot Key Indicators” on page 1
- 9) to toggle power to the PC Camera module. Make sure you install the drivers
in the order indicated in Table 4 - 1, on page 4 - 3.

Taking Still Pictures

Double-click the My
Computer icon on the
desktop, or go the Start
menu and point to My
Computer, then click it.

.Double-click the camera
icon. Click Take a new
picture in the Camera
Tasks box.
PC Camera Module 7 - 7
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PC Camera Driver Installation
1. Make sure the module is powered on, and then insert the Device Drivers 

& Utilities + User’s Manual disc into the CD/DVD drive. 
2. Click Option Drivers (button).
3. Click 1.Install Camera Driver > Yes.
4. Click Next > Install.
5. Click Finish to restart the computer.
6. Run the camera application program from the WebCam desktop shortcut 

(if the hardware is turned off use the Fn + F10 key combination to turn it on 
again).
7 - 8 PC Camera Module
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PC Camera Audio Setup
If you wish to capture video & audio with your camera, it is necessary to setup the
audio recording options in Windows.

1. Go to the Start menu and point to Settings (or just click Control Panel) and click 
Control Panel, then double-click the Sounds & Audio Devices icon (Sounds, 
Speech, and Audio Devices in Category View).

2. Click Advanced in the Volume > Device volume tab.
3. Click Options and scroll down and click Properties.
4. Select Realtek HD Audio Input from the Mixer device menu.
5. Make sure the Mic Volume (check box) is checked, then click OK.
6. Boost the volume in the Recording section (in the Recording Control menu) as 

high as it will go, and make sure the Select check box is checked.
7. Close the Recording Control window, and then click OK.
8. Double-click the Realtek HD Audio Manager icon  in the taskbar/control panel.
9. Click Mixer (tab).
10. Click the button under Mic Volume to select it (you can boost the volume level as 

high as required).
11. Click OK to close the control panel.
12. Run the WebCam application program from the desktop shortcut.
13. Go to the Devices menu heading and select Realtek HD Audio Input (it should 

have a tick alongside it).
14. Go to the Capture menu heading and select Capture Audio (it should have a tick 

alongside it).
PC Camera Module 7 - 9
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Camera Application
The WebCam application is a video viewer for general purpose video viewing and
testing, and for capturing video files to .avi format.

1. Run the camera application from the desktop shortcut (it is recommended that you 
set the capture file before the capture process - see Set Capture File below).

2. Go to the Capture menu heading (if you wish to capture audio check “PC Camera 
Audio Setup” on page 7 - 9) and select Start Capture.

3. Click OK (the file location will be displayed in the pop-up box) to start capturing the 
video, and press Esc to stop the capture (you can view the file using the Windows 
Media Player).

Set Capture File
Prior to capturing video files you may select the Set Capture File... option in the
File menu, and set the file name and location before capture (this will help avoid ac-
cidentally overwriting files). Set the name and location then click Open/Save, then
set the “Capture file size:” and click OK. You can then start the capture process as
above.

Note the important information in “Reducing Video File Size” on page 7 - 11 in or-
der to save file space, and help prevent system problems.

Pre-Allocating File 
Space

You may pre-allocate the
file size (File > Allocate
File Space) for the cap-
ture file in the camera ap-
plication.

Pre-allocating space on
the hard disk can improve
the capture quality (par-
ticularly of large capture
files), by reducing the
amount of work the hard
disk has to do in finding
space for the video data
as it is being captured.

See also “Reducing Vid-
eo File Size” on page 7 -
11.
7 - 10 PC Camera Module
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Reducing Video File Size
Note that capturing high resolution video files requires a substantial amount of disk
space for each file. After recording video, check the video file size (right-click the
file and select Properties) and the remaining free space on your hard disk (go to My
Computer, right-click the hard disk, and select Properties) If necessary you can re-
move the recorded video file to a removable medium e.g. CD, DVD or USB Flash
drive.

Note that the Windows XP system requires a minimum of 1.5GB of free space on
the C: drive system partition. In order to prevent system problems it is recommend-
ed that you save the captured video file to a location other than the C: drive (see “Set
Capture File” on page 7 - 10), limit the file size of the captured video (see “Pre-
Allocating File Space” on page 7 - 10) or reduce video resolution (see below).

To Reduce Video Resolution Output Size:

1. Run the camera application from the desktop shortcutGo to Options and scroll 
down to select Video Capture Pin....

2. Click the Output Size drop box and select a lower resolution size in order to 
reduce the captured file size.
PC Camera Module 7 - 11
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Eliminating Screen Flicker
If you find that the video screen in the camera application is flickering, you can try
to adjust the setting in the Video Capture Filter options.

1. Run the camera application from the desktop shortcut.
2. Go to Options and scroll down to select Video Capture Filter....
3. Click either 50Hz or 60Hz under Frequency in Property Page (tab).

Figure 7 - 6
Video Capture 

Filter
7 - 12 PC Camera Module
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Zoom
The camera application allows you to zoom the camera in and out.

1. Run the camera application from the desktop shortcut.
2. Go to Zoom and select Zoom Out/Zoom In.
3. Go to Options and scroll down to select Setting (Use the slider to adjust the zoom 

level, and click OK to save the setting).

Taking Still Pictures
The camera application allows you to take still pictures.

1. Run the camera application from the desktop shortcut.
2. Go to Options and select Take Picture/Snapshot.
3. The picture (in JPEG format) will be placed in the Snapshot folder  on the 

desktop.

Figure 7 - 7
Zoom/Setting

Snapshot Folder

The Snapshot folder’s
default location is on the
desktop. Do not move
this folder or an error
may appear when you
try to take a still picture.

If you accidentally de-
lete or move the folder,
you can create a new
Snapshot folder on the
desktop in order to cap-
ture the files.
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Wireless LAN Module
If you have included an Intel® Wi-Fi Link 1000 Series (802.11 b/g/n), 3rd Party
802.11b/g or 3rd Party 802.11b/g/n WLAN module in your purchase option, make
sure that the Wireless LAN module is on before installing the driver (the WLAN
module’s default power state is off).

Use the Fn + F11 key combination (see “Function/Hot Key Indicators” on page 1
- 9) to toggle power to the Wireless LAN module. Make sure you install the drivers
in the order indicated in Table 4 - 1, on page 4 - 3. Your installation procedure will
be dependent upon which WLAN module is included in your purchase option.

Wireless Device 
Operation Aboard 

Aircraft

The use of any portable
electronic transmission
devices aboard aircraft
is usually prohibited.
Make sure the mod-
ule(s) are OFF if you are
using the computer
aboard aircraft.

Use the Fn + F11 key
combination to toggle
power to the WLAN
module, and check the
indicator to see if the
module is powered on or
not (see Table 1 - 2, on
page 1 - 9/ Table 1 - 3,
on page 1 - 11).

Download Prerequisite Files (Intel WLAN module if Service Pack 3 is NOT 
installed)

Make sure you install Windows XP Service Pack 3 (or a Windows XP version which
includes Service Pack 3) before installing the Intel WLAN driver. If you DO NOT have
Service Pack 3 installed then make sure you have a working internet connection be-
fore beginning the driver installation process for Windows XP. 

You will be pointed to download the required Windows Installer 3.1 and Microsoft
MSXML 6.0 files. as part of the installation procedure overleaf. This information applies
to Intel WLAN modules only.
7 - 14 Wireless LAN Module



Modules & Options

7

Intel WLAN Driver Installation
1. Make sure the module is powered on, and then insert the Device Drivers 

& Utilities + User’s Manual disc into the CD/DVD drive.
2. Make sure the computer has a working internet connection if Service Pack 

3 is not installed.
3. Click Option Drivers (button).
4. Click 2.Install WLAN Driver > Yes (if SP3 is installed go straight to 

step 12).
5. Click Next > Next to link to the required prerequisites on the internet.
6. Click Download (button) to download the Windows Installer executable 

(.exe) file to the computer’s hard disk.
7. Double-click (or click the Run button) to install the Windows Installer file 

and follow the on-screen instructions for file installation.
8. You will be required to restart the computer to complete the file installation.
9. Repeat steps 1 to 4 to get to the appropriate download location.
10. Click Download (button) to download the Microsoft MSXML file to the 

computer’s hard disk (if you are unsure of which file to download for you 
processor you can click Run instead of acknowledging the file, and you 
will be informed if the file is appropriate or not).

11. Follow the on-screen instructions for file installation.
12. After the files have been installed click Next > Next.
13. Click the button to accept the license and click Next > Next > Next.
14. Click Finish to complete the installation.
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15. Configure the settings by going to the Intel PROSet Wireless WiFi Con-
nection Utility (Start > Programs/All Programs > Intel PROSet Wire-
less WiFi Connection Utility), or by double-clicking the taskbar icon .

16. Click to select any available network, and click Connect to establish a con-
nection.

17. If you do not see your Wireless Access Point click Refresh (button).
18. Click Help (link) to bring up the Help Menu.
19. Make sure that the WiFi On button is selected.

Figure 7 - 8 - Intel PROSet Wireless WiFi Connection Utility
7 - 16 Wireless LAN Module
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3rd Party 802.11b/g or 802.11b/g/n WLAN Driver Installation
1. Make sure the module is powered on, and then insert the Device Drivers 

& Utilities + User’s Manual disc into the CD/DVD drive.
2. Click Option Drivers (button).
3. Click 2.Install WLAN Driver > Yes.
4. Choose the language you prefer and click Next.
5. Click Next > Install.
6. Click Finish.
7. The operating system is the default setting for Wireless LAN control in 

Windows XP.
8. Access any available wireless networks from Network Connections > 

Wireless Network Connection menu in Windows (or click the icon  
in the taskbar), and click View Wireless Connections.

Network 
Connection

Use the Windows Net-
work Connections con-
trol panel to access
available wireless net-
works (Start > Settings >
Network Connections
or Start > Connect To >
Show all Connections).

Figure 7 - 9 
Wireless Network 

Control Panels
Wireless LAN Module 7 - 17
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3.75G/HSPA Module
If you have included an optional 3.75G/HSPA (High Speed Packet Access) module
in your purchase option, you will have the appropriate application (3G Watcher,
HSPA Modem Interface or Mobile Partner) provided for your particular module.
Follow the instructions on page 1 - 15 to install the USIM card (supplied by your
service provider), and then install the application (see over for further details).

3.75G/HSPA Module 
Options

There are three optional
3.75G/HSPA modules
available for this series of
computer models. Each
module is supplied with the
appropriate application
software.

The module type supplied
may depend upon the com-
puter model purchased.
Check with your service
center for details.

Install the driver from the
Drivers Installer menu and
check the instructions for
the appropriate application
on the following pages.
7 - 18 3.75G/HSPA Module
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Before installing the application, make sure that the 3.75G/HSPA module is ON
(installing the driver with the module off will not allow the software to detect the
module hardware correctly). Use the Fn +  key combination (see “Function/Hot
Key Indicators” on page 1 - 9) to toggle power to the 3.75G/HSPA module. Note
that exiting the application does NOT turn off the 3.75G/HSPA module.

• 3G Watcher - See “3G Watcher Application Installation” on page 7 - 20 for 
driver installation information and “Setting Up a Carrier Profile” on page 7 - 
21 for instructions on using the 3G Watcher application.

• HSPA Modem Interface - See “HSPA Modem Interface Installation” on 
page 7 - 27 for driver installation information and “HSPA Modem Interface” 
on page 7 - 28 for instructions on using the HSPA Modem Interface.

• Mobile Partner - See “Mobile Partner Application Installation” on page 7 - 
36 for driver installation information and “Mobile Partner Application” on 
page 7 - 37 for instructions on using the Mobile Partner application.

3.75G/HSPA 
Modules & System 

Wake Up

Note that the 3.75G mod-
ules DO NOT support
system wake up on
3.75G/HSPA modem ac-
tivity.
3.75G/HSPA Module 7 - 19
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3G Watcher
With the 3.75G/HSPA module and USIM card (supplied by your service provider)
installed you may then install the 3G Watcher application. The 3G Watcher appli-
cation allows you to directly access your HSPA internet service from the computer.

3G Watcher Application Installation
1. Enable power to the module by pressing the Fn +  key combination 

(the module must be ON when the driver is being installed - give the mod-
ule about 10 seconds to power on).
If a Found New Hardware window appears, click Cancel (click Cancel for 
all Found New Hardware windows that appear).

2. Insert the Device Drivers & Utilities + User’s Manual disc into the CD/
DVD drive.

3. Click Option Drivers (button).
4. Click 3.3G Driver > Yes, and then click Next.
5. Click the button to accept the license agreement, and then click Install.
6. When the next screen appears wait (for about 2 minutes) until you see the 

message bubble “Found New Hardware” in the taskbar disappear before 
clicking Finish (this allows the hardware to detect the 3.75G/HSPA mod-
ule).

7. Access the 3G Watcher application from the Start menu (Start > Pro-
grams/All Programs > Sierra Wireless > 3G Watcher), or by double-
clicking the desktop icon .

Wireless Device 
Operation Aboard 

Aircraft

The use of any portable
electronic transmission
devices aboard aircraft
is usually prohibited.
Make sure the mod-
ule(s) are OFF if you are
using the computer
aboard aircraft.

Use the Fn + _ ( ) key
combination to toggle
power to the 3.75G/
HSPA modem module,
and check the indicator
to see if the module is
powered on or not (see
Table 1 - 2, on page 1 -
9/ Table 1 - 3, on
page 1 - 11).
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Setting Up a Carrier Profile
Although the connection information is stored on the USIM card supplied by the ser-
vice provider, you may need to set up the appropriate carrier profile in 3G Watcher. 

1. Power on the 3.75G/HSPA module using the Fn +  key combination.
2. Access the 3G Watcher application from the Start menu (Start > Programs/All 

Programs > Sierra Wireless > 3G Watcher), or by double-clicking the desktop 
icon .

3. Click Tools and select Options.
4. Click Profiles and then click the Add new profile button , and select WWAN 

profile.

Figure 7 - 10
Add WWAN Profile
3.75G/HSPA Module 7 - 21
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5. You can then enter a new profile name or choose a profile from the drop-down list 
provided by the software (see the sidebars for information on the profile details).

6. Click Apply > OK to save the information.
7. You can choose the profile from the pull-down menu.

Figure 7 - 11
User Options

Profile Details

If you have chosen the
profile from the drop-
down list then most of
the information in the
General and Advanced
tabs should be automat-
ically filled in for you
(however check with
your service provider for
the latest information as
you may at least need to
add in your Username
and Password).

Figure 7 - 12
Choose Profile

Profile Information

Click General and/or Ad-
vanced (and the sub-
menus under Advanced)
in the left menu, and then
click in any of the fields to
add the appropriate infor-
mation supplied by your
service provider.
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Connecting to the Service Provider
1. Power on the 3.75G/HSPA module using the Fn +  key combination.
2. You can access the 3G Watcher application from the Start menu (Start > 

Programs/All Programs > Sierra Wireless > 3G Watcher), or by double-clicking 
the desktop icon .

3. The software will run and display the service provider name (see “Setting Up a 
Carrier Profile” on page 7 - 21).

4. Click Connect  to begin the connection process.
5. The 3G Watcher application will then display the connection information in the 

window.

Figure 7 - 13
Connect Button

Figure 7 - 14
Connecting
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6. When the connection is successful a taskbar notification will appear (as below).

7. You can then access the internet, download e-mail etc. as per any internet 
connection.

8. While you are connected the taskbar icon will be green  (it will be red  when 
the program is running but not connected).

9. To disconnect click the Disconnect  icon.

10. The program will disconnect from the service provider.
11. The module will still be on, and you will need to press the Fn +  key 

combination to turn it off.

Figure 7 - 15
Connected 

Taskbar 
Notification

Figure 7 - 16
3GWatcher 
Connected
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12. If you click the 3G Watcher close icon  a message will be displayed asking you 
to click OK to confirm the program exit. 

13. Exiting the program DOES NOT turn off the 3.75G/HSPA module, and you will 
need to press the Fn +  key combination to turn off the module (pay careful 
attention to this aboard aircraft - see “Wireless Device Operation Aboard 
Aircraft” on page 7 - 20).

14. If the module is on and the computer enters a power-saving state, then the power 
status of the module on resuming from the power-saving state will be as below:

• If the 3.75G/HSPA module is on and the computer is Shut Down or Restarted; 
the module will be off when the computer starts up.

• If the 3.75G/HSPA module is on and the computer enters Sleep or Hibernate; 
the module will be off when the computer resumes from sleep.

Figure 7 - 17
Exit Warning
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Short Messaging Service
In addition to standard internet services you may also send and receive SMS text
messages using the 3G Watcher program, if your service supports SMS.

Reading SMS Messages
1. The SMS message indicator  in the main window will notify you of any new 

messages received.
2. Double-click the icon  or select Tools > SMS Express.
3. Select the inbox folder and select any message to read it.
4. You cannot receive any new messages if the USIM card becomes full, so you will 

need to delete some of the messages in order to free up space on the USIM card.

Creating and Sending SMS Messages
1. Double-click the icon  or select Tools > SMS Express.
2. Select File > New Message or click the New button.
3. Enter the recipient’s number in the To.. field or click the To.. button to select an 

entry from the phone book, and click the Message button.
4. Type in the message details in the message body area.
5. Click the Send button (or save the message to send later).

For more details on SMS see 3GWatcher Online Help from the Help > Help Top-
ics menu.
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HSPA Modem Interface
With the 3.75G/HSPA module and USIM card (supplied by your service provider)
installed you may then install the HSPA Modem Interface. The HSPA Modem In-
terface application allows you to directly access your HSPA internet service from
the computer.

HSPA Modem Interface Installation
1. Enable power to the module by pressing the Fn +  key combination 

(the module must be ON when the driver is being installed - give the mod-
ule about 10 seconds to power on).
If a Found New Hardware window appears, click Cancel (click Cancel for 
all Found New Hardware windows that appear).

2. Insert the Device Drivers & Utilities + User’s Manual disc into the CD/
DVD drive.

3. Click Option Drivers (button).
4. Click 3. 3G Driver > Yes, and then click Next. 
5. Click Next > Install.
6. Click Finish to restart the computer.
7. Access the HSPA modem interface from the Start menu (Start > Pro-

grams/All Programs > HSPA modem), or by double-clicking the HSPA 
modem icon on the desktop.

Wireless Device 
Operation Aboard 

Aircraft

The use of any portable
electronic transmission
devices aboard aircraft
is usually prohibited.
Make sure the mod-
ule(s) are OFF if you are
using the computer
aboard aircraft.

Use the Fn + _ ( ) key
combination to toggle
power to the 3.75G/
HSPA modem module,
and check the indicator
to see if the module is
powered on or not (see
Table 1 - 2, on page 1 -
9/ Table 1 - 3, on
page 1 - 11).
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HSPA Modem Interface
The connection information is stored on the USIM card supplied by the service pro-
vider.

1. Power on the 3.75G/HSPA module using the Fn +  key combination.
2. Access the HSPA Modem Interface from the Start menu (Start > Programs/All 

Programs > HSPA Modem > HSPA Modem), or by double-clicking the desktop 
icon .

3. If a USIM card is not installed then a message will appear to notify you of this (click 
OK to close the message and install the USIM card).

4. If you are required to enter a pin # then a message will appear to prompt you to 
enter a pin #. (Note: to change pin # go to Settings  and click OK in PIN 
code.)

5. Click the Network connection  button and the HSPA Modem interface 
window will display Connection Manager.

HSPA Modem 
Interface Help

To get help on HSPA
Modem Interface config-
uration and settings,
click the help icon 
and select Help.

Figure 7 - 18
HSPA Modem 

Interface Window

Connection Manager

The connection information is commonly stored on the USIM
card supplied by the service provider. However if your ser-
vice provider requires details such as IP Address, User-
name and Password etc. to be entered before connection
you can enter them in the Connection Manager tab, or
save the details in Profiles.
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6. Click Connect  to connect to your service provider.

7. The message “Network is connected” will be displayed when the network 
connection is successful. 

8. You can then access the internet, download e-mail etc. as per any internet 
connection.

Figure 7 - 19
Connecting to 

Network

Figure 7 - 20
Network is 
Connected
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9. While you are connected the upper right corner of the HSPA Modem Interface will 
display the upload and download rates, and the taskbar icon will display the 
connection speed.

10. To disconnect click the Disconnect  icon (Connection Manager).
11. The program will disconnect from the service provider.
12. The module will still be on, and you will need to press the Fn +  key 

combination to turn it off.

Adding a Profile
1. Access the HSPA Modem Interface from the Start menu (Start > Programs/All 

Programs > HSPA Modem > HSPA Modem), or by clicking the desktop icon.
2. Click the Network connection , and click Profiles (tab).

Figure 7 - 21
Uploading/

Downloading Rates 
and Speed

Figure 7 - 22
Profiles
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3. Click Add (button) and input any Network Settings required by your service 
provider.

4. Click OK to save the profile.

5. You can Edit or Delete profiles from the Profiles tab.
6. To use a profile click to select it, and then click Apply (button) and the settings will 

be transferred to Connection Manager.

Figure 7 - 23
Network Settings & 

Profiles
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Contacts
1. Access the HSPA Modem Interface from the Start menu (Start > Programs/All 

Programs > HSPA Modem > HSPA Modem), or by clicking the desktop icon.
2. Click Contacts  (button).

3. Click Refresh (button) to download the contacts from the USIM card to the 
computer.

4. The Contacts will then be displayed.
5. Double-click any contact to edit the information (or right-click and select Edit).
6. You can also Export/Import contacts by clicking the appropriate button.

Figure 7 - 24
Network Settings & 

Profiles
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Messages
1. Access the HSPA Modem Interface from the Start menu (Start > Programs/All 

Programs > HSPA Modem > HSPA Modem), or by clicking the desktop icon.
2. Click Messages  (button).

3. Click Refresh (button) to download the messages from the USIM card to the 
computer.

4. Click New (button) to create a new message.
5. You can either type the telephone number in the recipient field, or press To 

(button) to select the contact from the list.

SMS Service

In addition to standard in-
ternet services you may
also send and receive
SMS text messages us-
ing the HSPA Modem In-
terface, if your service
supports SMS.

Figure 7 - 25
Network Settings & 

Profiles
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6. Click to select a contact from the list and then click Add (button) and the phone 
number will automatically be added to the recipient field.

7. Type the message information into the message body and click Send (button) to 
send it, or Save to draft (button) to save the message.

8. Select any message to forward or delete it, or to reply to it.

Settings
1. Access the HSPA Modem Interface from the Start menu (Start > Programs/All 

Programs > HSPA Modem > HSPA Modem), or by clicking the desktop icon.
2. Click Settings  (button).

Figure 7 - 26
Settings
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3. Click OK alongside any of the options to configure the settings.
4. The Network can be configured for an Automatic (usually from the USIM card) or 

Manual connection.
5. The Network Mode can be configured for any appropriate mode required.

6. You can also change your settings for the Pin #, and input your phone number.
7. Exiting the program DOES NOT turn off the HSPA modem module, and you will 

need to press the Fn +  key combination to turn off the module (pay careful 
attention to this aboard aircraft - see “Wireless Device Operation Aboard 
Aircraft” on page 7 - 27).

8. If the module is on and the computer enters a power-saving state, then the power 
status of the module on resuming from the power-saving state will be as below:

• If the 3.75G/HSPA module is on and the computer is Shut Down or Restarted; 
the module will be off when the computer starts up.

• If the 3.75G/HSPA module is on and the computer enters Sleep or Hibernate; 
the module will be off when the computer resumes from sleep.

Figure 7 - 27 
Settings - Network/

Network Mode
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Mobile Partner
With the 3.75G/HSPA module and USIM card (supplied by your service provider)
installed you may then install the Mobile Partner application. The Mobile Partner
application allows you to directly access your HSPA internet service from the com-
puter.

Mobile Partner Application Installation
1. Enable power to the module by pressing the Fn +  key combination 

(the module must be ON when the driver is being installed - give the mod-
ule about 10 seconds to power on).
If a Found New Hardware window appears, click Cancel (click Cancel for 
all Found New Hardware windows that appear).

2. Insert the Device Drivers & Utilities + User’s Manual disc into the CD/
DVD drive.

3. Click Option Drivers (button).
4. Click 3. 3G Driver > Yes.
5. Choose the language you prefer and click OK.
6. Click I Agree (button) to accept the license agreement.
7. Click Next > Install.
8. Click Finish to restart the computer.
9. Access the Mobile Partner application from the Start menu (Start > Pro-

grams/All Programs > Mobile Partner), or by double-clicking the Mobile 
Partner icon on the desktop.

Wireless Device 
Operation Aboard 

Aircraft

The use of any portable
electronic transmission
devices aboard aircraft
is usually prohibited.
Make sure the mod-
ule(s) are OFF if you are
using the computer
aboard aircraft.

Use the Fn + _ ( ) key
combination to toggle
power to the 3.75G/
HSPA modem module,
and check the indicator
to see if the module is
powered on or not (see
Table 1 - 2, on page 1 -
9/ Table 1 - 3, on
page 1 - 11).
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Mobile Partner Application
You will need to contact your service provider to obtain the exact details of how ex-
actly to configure the settings on this page.

Profile Management
1. Power on the 3.75G/HSPA module using the Fn +  key combination.
2. Access the Mobile Partner application from the Start menu (Start > Programs/

All Programs > Mobile Partner), or by double-clicking the Mobile Partner icon 
on the desktop .

3. If you have not created a profile, click Tools and select Options, and then click 
Profile Management.

4. Click New  and input the appropriate information for Profile Name, APN 
and Authentication etc. as supplied by your service provider.

5. Click Save  to save the profile.

Mobile Partner Help

To get help on Mobile
Partner configuration
and settings, click the
Help menu and select
Online Help or press
F1.

Figure 7 - 28
Profile Management
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Connecting to the Service Provider
1. Power on the 3.75G/HSPA module using the Fn +  key combination.
2. Access the Mobile Partner application from the Start menu (Start > Programs/

All Programs > Mobile Partner), or by double-clicking the Mobile Partner icon 
on the desktop .

3. The software will run and you can select the Profile Name from the menu.
4. Click Connect  to begin the connection process.

5. The Mobile Partner application will then display the connection information.

Figure 7 - 29 
Connect

Figure 7 - 30
Network 

Connection Prompt
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6. When the connection is successful a taskbar notification will appear (as below).

7. You can then access the internet, download e-mail etc. as per any internet 
connection.

8. While you are connected the indicators in the Mobile Partner window will display 
uploading and downloading icons and a network icon in the taskbar .

9. To disconnect click the Disconnect  icon, or right click the taskbar icon 
and select Disconnect.

10. The program will disconnect from the service provider.
11. The module will still be on, and you will need to press the Fn +  key 

combination to turn it off.

Figure 7 - 31
Connected 

Taskbar 
Notification

Figure 7 - 32
Disconnect
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12. If you click the Mobile Partner close icon  a message will be displayed asking 
you to click OK to confirm the program exit and to terminate the connection. 

13. Exiting the program terminates the connection, but DOES NOT turn off the 3.75G/
HSPA module, and you will need to press the Fn +  key combination to turn off 
the module (pay careful attention to this aboard aircraft - see “Wireless Device 
Operation Aboard Aircraft” on page 7 - 20).

14. If the module is on and the computer enters a power-saving state, then the power 
status of the module on resuming from the power-saving state will be as below:

• If the 3.75G/HSPA module is on and the computer is Shut Down or Restarted; 
the module will be off when the computer starts up.

• If the 3.75G/HSPA module is on and the computer enters Sleep or Hibernate; 
the module will be off when the computer resumes from sleep.

Figure 7 - 33
Exit Prompt
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Text Messaging Service
In addition to standard internet services you may also send and receive SMS text
messages using the Mobile Partner program, if your service supports SMS.

Reading SMS Messages
1. An icon  will blink at the bottom of the Mobile Partner interface to notify you of 

any new messages received.
2. Click the Text icon  in the Mobile Partner Interface.
3. Select the Local > Inbox or SIM/USIM Card folder and select any message to 

read it.
4. Right-click the message and choose an option to reply, forward or delete the 

message.

Creating and Sending SMS Messages
1. Click the Text icon  in the Mobile Partner Interface.
2. Click the New button .
3. Enter the recipient’s number in the Send To... field or click the Send To... button to 

select an entry from the phone book, and click OK.
4. Type in the message details.
5. Click the Send button, Save button to send the message later or Close > Yes to 

save in the Draft folder.

For more details on SMS click the Help menu and select Online Help or press F1
and select SMS.
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Chapter 8: Troubleshooting
Overview
Should you have any problems with your computer, before consulting your service representative, you may want
to try to solve the problem yourself. This chapter lists some common problems and their possible solutions. This
can’t anticipate every problem, but you should check here before you panic. If you don’t find the answer in these
pages, make sure you have followed the instructions carefully and observed the safety precautions in the preface.
If all else fails, talk to your service representative. You should also make a record of what happened and what
remedies you tried.

Of course, if something goes wrong, it will happen at the most inconvenient time possible, so you should preview
this section just in case. If, after you’ve tried everything, and the system still won’t cooperate, try turning it off
for a few minutes and then rebooting. You will lose any unsaved data, but it may start working again. Then call
your service representative.
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Basic Hints and Tips
Many of the following may seem obvious but they are often the solution to a problem when your computer ap-
pears not to be working. 

• Power - Is the computer actually plugged into a working electrical outlet? If plugged into a power strip, 
make sure it is actually working. Check the LED Power & Communication Indicators (see Table 1 - 3, on 
page 1 - 11) to see the computer’s power status.

• Connections - Check all the cables to make sure that there are no loose connections anywhere.

• Power Savings - Make sure that the system is not in Hibernate or Sleep mode by pressing the keys config-
ured in your Power Management/Power Options (see “Configuring the Power Button” on page 3 - 8), the 
Fn + F4 key combination, or power button to wake-up the system.

• Brightness - Check the brightness of the screen by pressing the Fn + F8 and F9 keys to adjust the bright-
ness.

• Display Choice - Press Fn + F7 to make sure the system is not set to “external only” display.

• Boot Drive - Make sure there are no optical media and/or USB storage devices in any connected drive 
when you start up your machine (this is a common cause of the message “Invalid system disk - Replace the 
disk, and then press any key” / “Remove disks or other media. Press any key to restart”).
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Backup and General Maintenance
• Always backup your important data, and keep copies of your OS and programs safe, but close to hand. 

Don’t forget to note the serial numbers if you are storing them out of their original cases, e.g. in a CD wal-
let.

• Run maintenance programs on your hard disk and OS as often as you can. You may schedule these pro-
grams to run at times when you are not using your computer. You can use those that are provided free with 
your OS, or buy the more powerful dedicated programs to do so.

• Write down your passwords and keep them safe (away from your computer). This is especially important if 
you choose to use a Supervisor password for the BIOS (see “The Power-On Self Test (POST)” on page 5 - 
2).

• Keep copies of vital settings files such as network, dialup settings, mail settings etc.(even if just brief notes).

Warranty
The CPU is not a user serviceable part. Opening this compartment, or accessing the CPU in any way, may violate your war-
ranty.
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Viruses
• Install an Anti-Virus program and keep the definitions file (the file which tells your program which viruses 

to look for) up to date. New computer viruses are discovered daily, and some of them may seriously harm 
your computer and cause you to lose data. Anti-Virus programs are commercially available and the defini-
tions file updates are usually downloadable directly from the internet.

• Be careful when opening e-mail from sources you don’t know. Viruses are often triggered from within e-
mail attachments so take care when opening any attached file. You can configure most Anti-Virus pro-
grams to check all e-mail attachments. Note: You should also beware of files from people you know as the 
virus may have infected an address book and been automatically forwarded without the person’s knowl-
edge.

• Keep a “Bootable CD-ROM/DVD-ROM/USB storage device” (this CD/DVD/USB device provides basic 
information which allows you to startup your computer) handy. You may refer to your OS’s documentation 
for instructions on how to make one, and many Anti-Virus programs will also provide such a disk (or at 
least instructions on how to make one).
8 - 4 Viruses



Troubleshooting

8

Upgrading and Adding New Hardware/Software
• Do not be tempted to make changes to your Windows Registry unless you are very sure of what you are 

doing, otherwise you will risk severely damaging your system.

• Don’t open your computer or undertake any repair or upgrade work if you are not comfortable with what 
you are doing.

• Read the documentation. We can assume, since you are reading this that you are looking at the computer’s 
manual, but what about any new peripheral devices you have just purchased? Many problems are caused by 
the installation of new hardware and/or software. Always refer to the documentation of any new hardware 
and/or software, and pay particular attention to files entitled “READ ME” or “READ ME FIRST”.

• When installing a new device always make sure the device is powered on, and in many cases you will need 
to restart the computer. Always check that all the cables are correctly connected.

• Make sure you have installed the drivers for any new hardware you have installed (latest driver files are 
usually available to download from vendor’s websites).
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• Thoroughly check any recent changes you made to your system as these changes may affect one or more 
system components, or software programs. If possible, go back and undo the change you just made and see 
if the problem still occurs.

• Don’t over complicate things. The less you have to deal with then the easier the source of the problem may 
be found; Example - if your computer has many devices plugged into its ports, and a number of programs 
running, then it will be difficult to determine the cause of a problem. Try disconnecting all of the devices and 
restarting the computer with all the peripheral devices unplugged. A process of elimination (adding and 
removing devices and restarting where necessary) will often find the source of a problem, although this may 
be time consuming.
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Problems and Possible Solutions

Problem Possible Cause - Solution

You turned on the power but it doesn’t
work.

Battery missing / incorrectly installed. Check the battery bay, make sure the
battery is present and seated properly (the design of the battery only allows it to
go in one way). Make sure there’s nothing interfering with the battery contacts.

The battery LED power indicator , is
blinking orange.

Low Battery. Plug in the DC power source. If the computer doesn’t start up
immediately, turn it off then on again.

You are losing battery power too quickly. The system is using too much power. If your OS has a Power Options Scheme
(see “Power Schemes” on page 3 - 4) check its settings. You may also be
using a USB device/external device that is drawing a lot of power.

Actual battery operating time is shorter
than expected.

The battery has not been fully discharged before being recharged. Make sure
the battery is fully discharged and recharge it completely before reusing (see
“Battery Information” on page 3 - 9).

Power Options have been disabled. Go to the Control Panel in Windows and
re-enable the options.

A peripheral device is consuming a lot of power. Turn off the unused device to
save power.
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The computer feels too hot. Make sure the computer is properly ventilated and the Vent/Fan intakes are not
blocked. If this doesn’t cool it down, put the system into Hibernate mode or turn
it off for an hour. Make sure the computer isn’t sitting on a thermal surface (see
“Overheating” on page 1 - 13). Make sure you’re using the correct adapter. 

Make sure that your notebook is completely powered off before putting it into a
travel bag (or any such container). Putting a notebook which is powered on in a
travel bag may cause the Vent/Fan intakes to be blocked.

Nothing appears on screen. The system is in a power saving mode. Toggle the sleep/resume key
combination, Fn + F4 (see “Hibernate” on page 3 - 7/“Configuring the Power
Button” on page 3 - 8).

The screen controls need to be adjusted. Toggle the screen control key
combinations Fn + F8/F9. If you’re connected to an external monitor, make sure
it’s plugged in and turned on. You should also check the monitor’s own
brightness and contrast controls.

The computer is set for a different display. Toggle the screen display key
combination, Fn + F7. If an external monitor is connected, turn it on.

The screen saver is activated. Press any key or touch the TouchPad.

Problem Possible Cause - Solution
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No image appears on the external
monitor I have plugged in and powered
on.

You haven’t installed the video driver and configured it appropriately from the
Control Panel. See “Display Devices & Options” on page B - 5 for
instructions on installing and configuring the video driver.

You forget the boot password. If you forget the password, you may have to discharge the battery of the CMOS.
Contact your service representative for help.

The sound cannot be heard or the volume
is very low.

The volume might be set too low. Check the volume control in the Volume
Control Panel in the Windows taskbar, or use the key combination Fn + F5 and
F6 (see “Function/Hot Key Indicators” on page 1 - 9) to adjust.

Audio cannot be recorded from the built-
in or external microphone.

The audio recording options need to be configured from the Realtek HD Audio
Manager. See “Audio Recording from Microphone” on page 2 - 9 for
configuration information, and “PC Camera Audio Setup” on page 7 - 9 for
information on recording audio from the PC Camera.

Problem Possible Cause - Solution

Password Warning
If you choose to set a boot password, NEVER forget your password. The consequences of this could be serious. If you cannot
remember your boot password you must contact your vendor and you may lose all of the information on your hard disk.
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Unwelcome numbers appear when
typing.

Check that Num Lock is not turned ON.

The system freezes or the screen goes
dark.

The system’s power saving features have timed-out. Use the AC/DC adapter,
press the sleep (Fn + F4) key combination, or press the power button if no LEDs
are lit.

The system never goes into a power
saving mode.

Power Options features are not enabled. Go to the Windows Power Options
menu and enable the features you prefer (see “System Power Options” on
page 3 - 6). Make sure you have enabled Hibernate mode from the control
panel.

The Wireless LAN or Bluetooth modules
cannot be detected.

The modules are off. Check the LED indicator  and/or function key indicator
to see if the WLAN or Bluetooth module is on or off (see Table 1 - 3, on page 1
- 11). If the LED indicator is off, then press the Fn + F11 (WLAN) or Fn + F12
(Bluetooth) key combination(s) in order to enable the modules (see “Function/
Hot Key Indicators” on page 1 - 9).

Problem Possible Cause - Solution

Other Keyboards
If your keyboard is damaged or you just want to make a change, you can use any standard USB keyboard. The system will
detect and enable it automatically. However special functions/hot keys unique to the system’s regular keyboard may not
work.
8 - 10 Problems and Possible Solutions
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The PC Camera module cannot be
detected.

The module is off. Press the Fn + F10 key combination in order to enable the
module (see “Function/Hot Key Indicators” on page 1 - 9). Run the WebCam
application to view the camera picture.

The Wireless LAN, Bluetooth or PC
Camera modules cannot be configured.

The driver(s) for the module(s) have not been installed. Make sure you have
installed the driver for the appropriate module (see the instructions for the
appropriate module in “Modules & Options” on page 7 - 1).

A file cannot be copied to/from a
connected Bluetooth device.

The transfer of data between the computer and a Bluetooth enabled device is
supported in one direction only (simultaneous data transfer is not
supported). If you are copying a file from your computer to a Bluetooth enabled
device, you will not be able to copy a file from the Bluetooth enabled device to
your computer until the file transfer process from the computer has been
completed

The Bluetooth module is off after
resuming from Sleep.

The Bluetooth module’s default state will be off after resuming from the Sleep
power-saving state. Use the key combination (Fn + F12) to power on the
Bluetooth module after the computer resumes from Sleep.

The Card Reader/Network (LAN) Device
does not appear in the Device Manager in
Windows.

This is a power saving feature. When not in use the Card Reader/Network (LAN)
Device will not appear in the Windows Device Manager as they are not
consuming any power. However as soon as the Card Reader is reading from/
writing to an inserted card, or the LAN card is experiencing network activity, the
device will reappear in the Windows Device Manager.

Problem Possible Cause - Solution
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Appendix A: Interface (Ports & Jacks)
Overview
The following chapter will give a quick description of the interface (ports & jacks) which allow your computer
to communicate with external devices, connect to the internet etc.
Interface (Ports & Jacks) A - 1
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Notebook Ports and Jacks
Item Description

Card Reader Port The card reader allows you to use some of the latest digital storage cards. Push the card into the
slot and it will appear as a removable device.

DC-In Jack Plug the supplied AC/DC adapter into this jack to power your computer.

External Monitor Port This port allows you to connect an external monitor, or Flat Panel Display, to get dual video or
simultaneous display on the LCD and external monitor/FPD.

Headphone-Out Jack Headphones or speakers may be connected through this jack. Note: Set your system’s volume to
a reduced level before connecting to this jack.

Microphone-In Jack Plug an external microphone in to this jack to record on your computer (see “Audio Recording
from Microphone” on page 2 - 9 for configuration information).

RJ-45 LAN Jack This port supports LAN (Network) functions.
Note: Broadband (e.g. ADSL) modems usually connect to the LAN port.

Security Lock Slot To prevent possible theft, a Kensington-type lock can be attached to this slot. Locks can be
purchased at any computer store.
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USB 2.0/1.1 Ports These USB 2.0 compatible ports (USB 2.0 is fully USB 1.1 compliant) are for low-speed
peripherals such as keyboards, mice or scanners, and for high-speed peripherals such as
external HDDs, digital video cameras or high-speed scanners etc. Devices can be plugged into
the computer, and unplugged from the computer, without the need to turn the system off (if the
power rating of your USB device is 500mA or above, make sure you use the power supply which
comes with the device).

Item Description
Interface (Ports & Jacks) A - 3
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Appendix B: Intel Video Driver Controls
The basic settings for configuring the LCD are outlined in “Video Features” on
page 1 - 17.

Intel Video Driver Installation
Make sure you install all the drivers in the order indicated in Table 4 - 1, on page 4 - 3.

Video
1. Insert the Device Drivers & Utilities + User’s Manual disc into the CD/

DVD drive.
2. Click 2.Install Video Driver > Yes.
3. Click Next > Yes > Next > Next.
4. Click Finish to restart the computer.

Dynamic Video Memory Technology
Intel® DVMT automatically and dynamically allocates as much (up to 128MB) sys-
tem memory (RAM) as needed to the video system (the video driver must be in-
stalled). DVMT returns whatever memory is no longer needed to the operating
system.

DVMT Notes

DVMT is not local video
memory.

DVMT is not user-con-
figurable.

DVMT will not function
in MS-DOS. DOS uses
the legacy memory indi-
cated.
Intel Video Driver Installation B - 1
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Intel Graphics Properties
More advanced video configuration options are provided by the Intel(R) Graphics
Media Accelerator Driver for Mobile.

1. Open Display Properties (see “Video Features” on page 1 - 17) and click 
Advanced.

2. Click the Intel(R)... tab and click Graphics Properties (button).
3. You can also access Graphics Properties from the Windows Intel(R) GMA

Driver for Mobile control panel, or from the taskbar icon . 

Taskbar Icon

You can also access the
controller properties
from the taskbar. Click
on the icon to bring up
the menu and scroll to
Graphics Properties.

If you cannot see the
tray icon go to the In-
tel(R) Graphics Media
Accelerator Driver tab
(in the Display Proper-
ties > Advanced op-
tions) and click the
“Show Tray Icon” tick-
box.

Figure B - 1
Intel Graphics 

Properties
B - 2 Intel Graphics Properties
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You may make changes to the devices, color, schemes, Hot Keys etc. by clicking
the appropriate menu item or button.

Help Menus

Right-click on many of
the items in the tabs to
bring up the “What’s
This?” button.

Click the “What’s
This?” button to bring
up the help menu.

Multiple Display 

At least one other dis-
play must be attached in
order to view Multiple
Display selection op-
tions.

Figure B - 2
Intel Graphics Media 
Accelerator Driver 

for mobile
(Control Panel Tabs)
Intel Graphics Properties B - 3
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Scheme Options
Use Scheme Options to configure quick settings for applications which require spe-
cific resolution and color settings in order to run properly e.g. games, multimedia
programs. To set the scheme options:

1. Go to the Graphics Properties control panel (see “Intel Graphics Properties” 
on page B - 2).

2. Configure your display configuration, resolution etc. as per your requirements,
from Display Devices (tab).

3. Click on Scheme Options (button).
4. Type a name for the scheme then click Save.
5. If you want to automatically launch an application when running the scheme click

on Browse (button).
6. Browse to the executable file for the application you want to set the scheme for

(see sidebar), and click Open to select it.
7. Click Save to save the settings (you can click in the “Restore the display settings

after exiting this application” box to return to your original settings when you exit
the program).

8. Click OK to exit the program.
9. You can run the scheme by clicking the taskbar icon  and selecting the scheme

from Select Scheme.

Application.exe

You will need to locate
the actual application
executable (.exe) file,
not just the shortcut. To
find the application right-
click its shortcut on the
desktop click Proper-
ties. Click the Shortcut
(tab) and see where the
executable file is located
by clicking the Find Tar-
get (button). Note the lo-
cation and you will then
be able to browse to this
file.

Figure B - 3
Select Scheme
B - 4 Intel Graphics Properties
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Display Devices & Options
Besides the built-in LCD, you can also use an external VGA monitor (CRT) or ex-
ternal Flat Panel Display as your display device. A VGA monitor/Flat Panel Dis-
play connects to the external monitor port. The following display modes are
available.

Intel Display Mode Description

Single Display One of the connected displays is used as the display 
device

Multiple Display - Intel(R) 
Dual Display Clone

Both connected displays output the same view and may be 
configured independently

Multiple Display - Extended 
Desktop

Both connected displays are treated as separate devices, 
and act as a virtual desktop

Function Key 
Combination

You can use the Fn + F7
key combination to tog-
gle through the display
options:

• Notebook Only
• External Display Only
• Notebook + External 

Display

Make sure you give the
displays enough time to
refresh.

Table B - 1
Display ModesAttaching Displays

When you first attach an external display you may find that the desktop does not occupy
the full screen area. Use either the display’s auto adjust/configure controls, or the Intel(R)
GMA Driver for Mobile control panel to configure the full screen display.
Intel Graphics Properties B - 5
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Attaching Other Displays
If you prefer to use a monitor or flat panel display, connect it to the external monitor
port on the left of the computer.

To Enable Intel(R) Dual Display Clone Mode
1. Attach your external display to the external monitor port, and turn it on.
2. Go to the Intel(R) GMA Driver for mobile control panel and click Display

Devices.
3. Click to choose Intel(R) Dual Display Clone (Multiple Display).
4. Click Apply, and OK to confirm the settings change.
5. Click Display Settings to adjust the settings for the attached devices.

Multiple Display 

At least one other dis-
play must be attached in
order to view Multiple
Display selection op-
tions.

BIOS Setting

Make sure that you have
not disabled external
display detection in the
BIOS if attempting to
connect external dis-
plays (see “Detect Ex-
ternal CRT (Advanced
Menu)” on page 5 -
10).

Figure B - 4
 Display Devices

Video Settings

Click Video Settings
(button) in the Intel(R)
GMA Driver for mobile
control panel to access
settings for Video Quali-
ty, Color Control and
Video Scaling. 
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To Enable Extended Desktop Mode:
1. Attach your external display to the external monitor port, and turn it on.
2. Go to the Intel(R) GMA Driver for mobile control panel and click Display

Devices.
3. Click to choose Extended Desktop (Multiple Display).
4. Click Apply, and OK to confirm the settings change.
5. Click Display Settings to adjust the settings for the attached devices.

You can also enable the Extended Desktop mode from the Display Properties con-
trol panel (see page B - 8).

 Display Settings 
Extended Desktop 

You can have different
Colors, Screen Area
and Monitor Refresh
Rates for each display
device provided your
monitor can support
them.

You can drag the moni-
tor icons to match the
physical layout of your
displays. Icons and pro-
grams may also be
dragged between the
displays.

Figure B - 5 
Extended Desktop 

Mode

Click the appropriate monitor
icon and drag it to match the
physical arrangement you
wish to use (e.g. the second-
ary display may be extended
left/right/above/below  the
primary display).

Click Display Settings to
make any adjustments re-
quired.
Attaching Other Displays B - 7
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To Enable Extended Desktop (Windows Display Properties)
1. Attach your external monitor to the external monitor port, and turn it on.
2. Click Start, point to Settings (or click Control Panel) and click Control Panel (if

you are in Category View choose Appearance and Themes).
3. Double-click Display (icon).
4. In the Display Properties dialog box, click Settings (tab).
5. Click the monitor icon (e.g. ), and make sure you have checked “Extend my

Windows desktop onto this monitor.” and click Apply.

 Display Settings 
Extended Desktop 

Use the control panel to
drag the monitors to
match the physical ar-
rangement you wish to
use. 

You can drag any icons
or windows across to ei-
ther display desktop,
which makes it possible
to have one program
visible in one of the dis-
plays, and a different
program visible in the
other display.

Figure B - 6
Display Properties 

(Extended Desktop)

2

Click the appropriate monitor
icon (e.g. ) to be able to select
the option to extend the desktop
on to it.

In this example the Primary mon-
itor  is on the left, the secondary
display  is on the right.

2

1
2
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Appendix C: Specifications

Latest Specification Information

The specifications listed in this Appendix are correct at the time of going to press. Certain items (particularly processor types/
speeds and CD/DVD device types) may be changed, delayed or updated due to the manufacturer's release schedule. Check
with your service center for details.
Specifications C - 1
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Processor

Intel® Atom® Processor N270
(1.6 GHz 512KB On-die L2 Cache & 
533MHz FSB - BGA Package)

Intel® Atom® Processor N280
(1.66 GHz 512KB On-die L2 Cache & 
533MHz FSB - BGA Package)

Core Logic

Intel® 82945GSE +82801GBM

Display

10.1” WSVGA (1024 * 576) TFT LCD

Memory

One 200 Pin SO-DIMM Socket 
Supporting DDRII (DDR2) 533 MHz 
Memory
Memory Expandable up to 2GB

Video Adapter

Intel 945GSE Integrated Video

Supports DirectX 9.0

Shared Memory Architecture 
(up to 128MB shared video memory 
dynamically allocated from system 
memory where needed)

BIOS

One 8Mb SPI Flash ROM
Phoenix™ BIOS

Storage

One Changeable 2.5" 9.5 mm (h) SATA 
(Serial) Hard Disk Drive
Note: It is recommended that HDDs of a 
speed of 5400 RPM are used. DO NOT 
use 7200rpm HDDs. 

Security

Kensington Lock

Audio

High Definition Audio Compliant Interface
Compliant with Microsoft UAA (Universal 
Audio Architecture)
Direct Sound 3D™ Compatible
2 * Built-In Speakers
Built-In Microphone

Pointing Device

Built-in TouchPad (scrolling key 
functionality integrated)

Keyboard

“WinKey” keyboard (with embedded 
numeric keypad)

Interface

Two USB 2.0 Ports
One Headphone-Out Jack
One Microphone-In Jack
One External Monitor Port
One RJ-45 LAN Jack
One DC-in Jack
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Communication

10Mb/100Mb Base-T Ethernet LAN 
802.11b/g Wireless LAN Half Mini-Card 
Module (Option)
802.11b/g/n Wireless LAN Half Mini-Card 
Module (Option) 
1.3M Pixel USB PC Camera Module 
(Factory Option)
*Bluetooth 2.1 + EDR (Enhanced Data 
Rate) Module (Factory Option)
*UMTS/HSPDA-based 3.75G/HSPA 
Module with Mini Card Interface (Factory 
Option) 

Operating System

Windows XP with Service Pack 3
Windows 7

Card Reader

Embedded 7-in-1 Card Reader (MS/ MS 
Pro/ SD/ Mini SD/ MMC/ RS MMC/ MS 
Duo) 
Note: MS Duo/ Mini SD/ RS MMC Cards 
require a PC adapter

Slot

Two Mini-Card Slots (USB & PCIE)
Slot 1: for Wireless LAN Module (Half Mini-
Card)
Slot 2: for 3.75G/HSPA Module

Power Management

Wake On LAN
Wake On USB
Energy Star Compliant System

Power

Full Range AC/DC Adapter
AC Input: 100 - 240V, 50 - 60Hz
DC Output: 19V, 1.57A/1.58A (30 Watts)

Battery

Polymer Battery Pack, 3550mAh

Environmental Spec

Temperature 
Operating: 5°C - 35°C
Non-Operating: -20°C - 60°C
Relative Humidity
Operating: 20% - 80%
Non-Operating: 10% - 90%

Dimensions & Weight

Model A:
272mm (w) * 188.6mm (d) * 26.4 - 29.5mm (h)
Around 1.2 kg With Battery
Model B:
271mm (w) * 188.6mm (d) * 19.5 - 28mm (h)
Around 1.2 kg With Battery
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Optional

802.11b/g Wireless LAN Module
802.11b/g/n Wireless LAN Module
Intel® WiFi Link 1000 Series (802.11b/g/
n) Wireless LAN PCIe interface Half Mini-
Card Module
External USB Super Multi Optical Device 
Drive
1.3M Pixel USB PC Camera Module 
(Factory Option)
*Bluetooth 2.1 + EDR Module (Factory 
Option)
*UMTS/HSPDA-based 3.75G/HSPA 
Module (Factory Option) 
C - 4
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Appendix D: Windows 7 Information
This Appendix contains information on the driver installation for the Windows 7 OS. Note that control panels
(e.g. power and video) and configuration of certain items in Windows 7 may be different from Windows Vista.
Consult your Windows 7 documentation, or item specific help for further information.
D - 1
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Windows 7 Start Menu & Control Panel
Most of the control panels, utilities and programs within Windows 7 (and most other Windows versions) are ac-
cessed from the Start menu. When you install programs and utilities they will be installed on your hard disk
drive, and a shortcut will usually be placed in the Start menu and/or the desktop. Right-click the Start menu
icon , and then select Properties if you want to customize the appearance of the Start menu.

In many instances throughout this manual you will see an instruction to open the Control Panel. The Control
Panel is accessed from the Start menu, and it allows you to configure the settings for most of the key features
in Windows (e.g. power, video, network, audio etc.). Windows 7 provides basic controls for many of the features,
however many new controls are added (or existing ones are enhanced) when you install the drivers. To see all
controls it may be necessary to toggle off Category View to view the control panel icons.

Figure D - 1 - Start Menu & Control Panel

Click here to toggle Category View
 

D - 2 Windows 7 Start Menu & Control Panel
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Video Features
You can configure display options from the Display (Control Panel) and Screen Resolution in Windows. For
more detailed video information see  Chapter B“Intel Video Driver Controls” from page B - 1.

To access Display (Control Panel) and Screen Resolution in Windows:
1. Click Start and click Control Panel.
2. Click Display (icon) - In the Appearances and Personalization category.
3. Click Adjust Screen Resolution/Adjust resolution.
OR
4. Alternatively you can right-click the desktop and select Screen resolution (see right).
5. Use the dropbox to select the screen Resolution  (Figure D - 2 on page D - 4).
6. Click Advanced settings  (Figure D - 2 on page D - 4) to bring up the Advanced properties tabs.

To access the Intel(R) Graphics Media Accelerator Driver for mobile control panel:
1. Click Advanced settings  (Figure D - 2 on page D - 4) in the Screen Resolution control panel in Win-

dows.
2. Click the Intel(R)... tab  (Figure D - 2 on page D - 4) and click Graphics Properties (button).
OR
3. Right-click the desktop and select Graphics Properties from the menu.
OR
4. The Intel GMA control panel can also be accessed by clicking the icon  in the taskbar and selecting Graphics

Properties  (Figure D - 2 on page D - 4)  from the menu.

1
2

2

3

4
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Screen Resolution
Besides the built-in LCD, you can also use an external VGA monitor (CRT)/external Flat Panel Display as
your display device.

Figure D - 2 - Screen Resolution & Intel GMA Driver for Mobile Control Panel

1
2

3

4
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Attaching Other Displays
Configuring an External Display in Windows 7
1. Attach your external monitor to the external monitor port, and turn it on.
2. Go to the Screen resolution control panel.
3. Click the Detect button.
4. The computer will then detect any attached displays.

Figure D - 3 - Screen Resolution - Multiple Displays

Video Options

Note that card types, specifications
and drivers are subject to continual
updates and changes. Check with
your service center for the latest de-
tails on video cards supported.
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5. You can configure the displays from the Multiple Displays menu.

Figure D - 4 - Screen Resolution - Multiple Display Options
• Duplicate these displays - Shows an exact copy of the main display desktop on the other display(s)
• Extend these displays - Treats both connected displays as separate devices
• Show desktop only on 1/2 - Only one of your displays is used.

See “Display Modes” on page B - 8 for more details on the above modes when using the Intel driver to configure
attached displays.
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Windows 7 Driver Installation
Insert the Device Drivers & Utilities + User’s Manual
disc into an attached CD/DVD drive and click Install
Drivers/Option Drivers (button).

If you wish to install the drivers manually see overleaf
for the driver path information.

Figure D - 5 - Drivers Installer Screen 1

1. Check the driver installation order from Table D - 1, 
on page D - 8 (the drivers must be installed in 
this order) which is the same as that listed in the 
Drivers Installer menu below.

2. Click to select the driver you wish to install, after 
installing each driver it will become grayed out (if 
you need to reinstall any driver, click the Unlock 
button).

3. Follow the instructions for each individual driver 
installation procedure as listed on the following 
pages.

 
Figure D - 6 - Drivers Installer Screen 2
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Table D - 1 - Driver Installation

Driver - Windows 7 Page #

Chipset Page D - 10

Video Page D - 10

Audio Page D - 10

LAN Page D - 10

TouchPad Page D - 10

Card Reader Page D - 10

Hot Key Page D - 11

PC Camera Module Page D - 13

Wireless LAN Module Page D - 15

3.75G/HSPA Module Page D - 18
Page D - 19
D - 8 Windows 7 Driver Installation
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Updating/Reinstalling Individual Drivers
If you wish to update/reinstall individual drivers it may
be necessary to uninstall the original driver.To do this go
to the Control Panel in the Windows OS and double-
click the Programs and Features item (Programs >
Uninstall a program). If you see the individual driver
listed (if not see below), uninstall it, following the on
screen prompts (it may be necessary to restart the com-
puter). Go to the appropriate section of the manual to
complete the update/reinstall procedure for the driver in
question.

If the driver is not listed in the Programs and Features
item:
1. Click Start and click Control Panel. 
2. Double-click System (icon); System (icon) is in 

System and Security (category).
3. Click Device Manager (in the left menu).
4. Double-click the device you wish to update/reinstall the 

driver for (you may need to click “+”).
5. Look for the Update Driver button (check the Driver 

tab) and follow the on screen prompts.

Driver Installation General Guidelines

The driver installation procedure outlined in this
Chapter are accurate at the time of going to press.

Drivers are always subject to upgrade and revision
so the exact procedure for certain drivers may differ
slightly. As a general guide follow the default on
screen instructions for each driver (e.g. Next > Next
> Finish) unless you are an advanced user. In many
cases a restart is required to install the driver.
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Driver Installation Procedure
Insert the Device Drivers & Utilities + User’s Manual
disc and click Install Drivers (button).

Chipset
1. Click 1.Install Chipset Driver > Yes.
2. Click Next > Yes > Next.
3. Click Finish.

Video
1. Click 2.Install Video Driver > Yes.
2. Click Next > Yes > Next > Next.
3. Click Finish to restart the computer.

Audio
1. Click 3.Install Audio Driver > Yes. 
2. Click Next > Yes.
3. Click Finish to restart the computer.

LAN
1. Click 4.Install LAN Driver > Yes. 
2. Click Install > Finish to complete the installa-

tion.
3. The network settings can now be configured.

TouchPad
1. Click 5.Install Touch Pad Driver > Yes.
2. Select the installation language and click OK.
3. Click Next.
4. Click Finish > Restart Now to restart the com-

puter.

Card Reader
1. Click 6.Install Cardreader Driver > Yes.
2. Click Install > Finish to complete the installa-

tion.
D - 10 Windows 7 Driver Installation
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Hot Key
1. Click 7.Install HotKey Driver > Yes. 
2. Click Next > Install.
3. Click Finish > Finish to restart the computer.

Optional Drivers
The following pages provide driver installation proce-
dures for any modules included in your purchase op-
tion. Refer to Chapter 7 as indicated for further
configuration information, however note that Win-
dows 7 configuration may be slightly different from
that indicated in Windows Vista.

Make sure any modules (e.g. PC Camera, WLAN or
3.75G/HSPA) are ON before installing the appropriate
driver. Figure D - 7 - Drivers Installer - Option Drivers Menu
Windows 7 Driver Installation D - 11
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PC Camera Module
Before installing the PC Camera driver, make sure that the optional PC Camera is on. Use the Fn + F10 key
combination (see “Function/Hot Key Indicators” on page 1 - 9) to toggle power to the PC Camera module.
Make sure you install the drivers in the order indicated in Table D - 1, on page D - 8.

There are a number of different camera modules available with this computer model series. You will have the
appropriate application installed for your camera. Make sure you access the application via the desktop short-
cut.

PC Camera Screen Refresh

The PC Camera module supports a frame rate of 12 fps. If you find that the screen refresh rate is subject to lag or stuttering,
then reduce the window size, or adjust the Output Size and/or Color Space Compression. 

To reduce Output Size and/or Color Space Compression run the WebCam application, click Options and select Video
Capture Pin. Adjust the settings from the appropriate pull-down menu.
D - 12 Windows 7 Driver Installation
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PC Camera Driver Installation
1. Insert the Device Drivers & Utilities + User’s Manual disc into the CD/DVD drive.
2. Click Option Drivers (button).
3. Click 1.Install Camera Driver > Yes.
4. Choose the language you prefer and click Next > Next.
5. Click Finish to restart the computer.
6. Run the camera application program from the desktop shortcut (if the hardware is turned off use the 

Fn + F10 key combination to turn it on again).

See “PC Camera Module” on page 7 - 7 for driver installation and configuration information.
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Wireless LAN Module
If you have included an Intel® Wi-Fi Link 1000 Series (802.11 b/g/n), 3rd Party 802.11b/g or 3rd Party
802.11b/g/n WLAN module in your purchase option, make sure that the Wireless LAN module is on before in-
stalling the driver (the WLAN module’s default power state is off).

Use the Fn + F11 key combination (see “Function/Hot Key Indicators” on page 1 - 9) to toggle power to the
Wireless LAN module. Make sure you install the drivers in the order indicated in Table D - 1, on page D - 8.
Your installation procedure will be dependent upon which WLAN module is included in your purchase option.

 

Wireless Device Operation Aboard Aircraft

The use of any portable electronic transmission devices aboard aircraft is usually prohibited. Make sure the module(s) are
OFF if you are using the computer aboard aircraft.

Use the Fn + F11 key combination to toggle power to the WLAN module, and check the indicator to see if the module is
powered on or not (see Table 1 - 2, on page 1 - 9/ Table 1 - 3, on page 1 - 11).

Important Notice - 3.75G/HSPA & Bluetooth/Wireless LAN Modules

In order to comply with FCC regulations you should NOT operate the 3.75G/HSPA module and the Bluetooth/Wireless LAN
modules at the same time as this may disrupt radio frequency, and cause interference. When the 3.75G/HSPA module is
powered on, make sure that the Bluetooth/Wireless LAN modules are powered off.
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Intel® Wi-Fi Link Series Driver Installation
If you see the message “Found New Hardware” click Cancel to close the window.
1. Make sure the module is powered on, then insert the Device Drivers & Utilities + User’s Manual disc 

into the CD/DVD drive. 
2. Click Option Drivers (button).
3. Click 2.Install WLAN Driver > Yes.
4. An on-screen message will appear to show the progress of the WLAN installation.
5. When the message disappears the driver will be installed.
Note: The operating system is the default setting for Wireless LAN control in Windows 7 (see your Windows 7
documentation).

3rd Party 802.11b/g or 802.11b/g/n WLAN Driver Installation
If you see the message “Found New Hardware” click Cancel to close the window.
1. Make sure the module is powered on, then insert the Device Drivers & Utilities + User’s Manual disc 

into the CD/DVD drive. 
2. Click Option Drivers (button).
3. Click 2.Install WLAN Driver > Yes.
4. Select the installation language and click Next.
5. Click Install.
6. Click Finish.
Note: The operating system is the default setting for Wireless LAN control in Windows 7 (see your Windows 7
documentation).
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3.75G/HSPA Module
If you have included an optional 3.75G/HSPA (High Speed Packet Access) module in your purchase option,
you will have the appropriate application (HSPA Modem Interface or Mobile Partner) provided for your par-
ticular module. Follow the instructions on page 1 - 15 to install the USIM card (supplied by your service pro-
vider), and then install the application (see over for further details).

Important Notice - 3.75G/HSPA & Bluetooth/Wireless LAN Modules

In order to comply with FCC regulations you should NOT operate the 3.75G/HSPA module
and the Bluetooth/Wireless LAN modules at the same time as this may disrupt radio fre-
quency, and cause interference. When the 3.75G/HSPA module is powered on, make sure
that the Bluetooth/Wireless LAN modules are powered off.

Wireless Device Operation Aboard Aircraft

The use of any portable electronic transmission devices aboard aircraft is usually prohibit-
ed. Make sure the module(s) are OFF if you are using the computer aboard aircraft.

Use the Fn + _ ( ) key combination to toggle power to the 3.75G/HSPA modem module,
and check the indicator to see if the module is powered on or not (see Table 1 - 2, on
page 1 - 9/ Table 1 - 3, on page 1 - 11).
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Before installing the application, make sure that the 3.75G/HSPA module is ON
(installing the driver with the module off will not allow the software to detect the
module hardware correctly). Use the Fn +  key combination (see “Function/Hot
Key Indicators” on page 1 - 9) to toggle power to the 3.75G/HSPA module. Note
that exiting the application does NOT turn off the 3.75G/HSPA module.

• HSPA Modem Interface - See “HSPA Modem Interface Installation” on 
page D - 18 for driver installation information and “HSPA Modem Interface” 
on page 7 - 27 for instructions on using the HSPA Modem Interface (note that 
some Windows Vista information may appear slightly different from Win-
dows 7).

• Mobile Partner - See “Mobile Partner Application Installation” on page D - 
19 for driver installation information and “Mobile Partner Application” on 
page 7 - 37 for instructions on using the Mobile Partner application (note that 
some Windows Vista information may appear slightly different from Win-
dows 7).

3.75G/HSPA 
Modules & System 

Wake Up

Note that the 3.75G mod-
ules DO NOT support
system wake up on
3.75G/HSPA modem ac-
tivity.
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HSPA Modem Interface Installation
1. Enable power to the module by pressing the Fn +  key combination (the module must be ON 

when the driver is being installed - give the module about 10 seconds to power on).
If a Found New Hardware window appears, click Cancel (click Cancel for all Found New Hardware 
windows that appear).

2. Insert the Device Drivers & Utilities + User’s Manual disc into the CD/DVD drive.
3. Click Option Drivers (button).
4. Click 3. 3G Driver > Yes, and then click Next. 
5. Click Next > Install.
6. Click Finish to restart the computer.
7. Access the HSPA modem interface from the Start menu (Start > Programs/All Programs > HSPA 

modem), or by double-clicking the HSPA modem icon on the desktop.
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Mobile Partner Application Installation
1. Enable power to the module by pressing the Fn +  key combination (the module must be ON 

when the driver is being installed - give the module about 10 seconds to power on).
If a Found New Hardware window appears, click Cancel (click Cancel for all Found New Hardware 
windows that appear).

2. Insert the Device Drivers & Utilities + User’s Manual disc into the CD/DVD drive.
3. Click Option Drivers (button).
4. Click 3. 3G Driver > Yes.
5. Choose the language you prefer and click OK.
6. Click I Agree (button) to accept the license agreement.
7. Click Next > Install.
8. Click Finish to restart the computer.
9. Access the Mobile Partner application from the Start menu (Start > Programs/All Programs > 

Mobile Partner), or by double-clicking the Mobile Partner icon on the desktop.
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Other Notes:
Bluetooth Module
Note: The operating system is the default setting for Bluetooth control in Windows 7, and does not require a
driver. See your Windows 7 documentation for specific information.

Important Notice - 3.75G/HSPA & Bluetooth/Wireless LAN Modules

In order to comply with FCC regulations you should NOT operate the 3.75G/HSPA module
and the Bluetooth/Wireless LAN modules at the same time as this may disrupt radio fre-
quency, and cause interference. When the 3.75G/HSPA module is powered on, make sure
that the Bluetooth/Wireless LAN modules are powered off.

Wireless Device Operation Aboard Aircraft

The use of any portable electronic transmission devices aboard aircraft is usually prohibit-
ed. Make sure the module(s) are OFF if you are using the computer aboard aircraft.

Use the Fn + F12 key combination to toggle power to the Bluetooth module, and check the
LED indicator to see if the module is powered on or not (see Table 1 - 2, on page 1 - 9/
Table 1 - 3, on page 1 - 11).
D - 20 Other Notes:
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